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Introduction

RingCentral is a cloud communications system that delivers unified team messaging, collaboration, and
video meetings, coupled with unified voice, fax, and text for businesses of all sizes.
This guide will help system administrators set up and access the following RingCentral features.

To log in to your online account, follow these steps:

Hing

Navigate to RingCentral Admin Portal.
Enter your email or RingCentral phone number.

Click Next. Eomact o Prvces i

If you entered your phone number, select your country

from the dropdown menu and enter your extension —
number (optional) and password.

If you entered your email, enter your password.

6. ClickSignin.

b e

i

Unified Login

If you have both RingCentral and RingCentral app credentials which use the same email address, you will use
RingCentral credentials for logging in to all endpoints.

Email or Google as user ID

You may optionally configure users to log in with a unique corporate email address or Google (Gmail or G
Suite) account.

The Google login feature provides users native support for logging in using a Google email address and
password. This feature requires a unique Google email address (Gmail or G Suite email). The admin
configures a Google email address when assigning an extension, and verifies the uniqueness of the email
address. By default, users can log in with their Google email address or other RingCentral credentials.

This feature applies to accessing your RingCentral online account through endpoints such as RingCentral
app, integration plug-ins for Chrome, and the Multiple Account Access portal. You can configure Google
Email addresses during the Express Setup of your RingCentral account.


https://service.ringcentral.com
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If not already configured, set a Google email address using the following steps:

No s~ DhR

Navigate to RingCentral Admin Portal.

Log in using your RingCentral credentials.

Select Users > User List > Users with Extensions.

Select a user from the list.

On User Details > General tab, enter the Google email in the Email field.
Click Verify email uniqueness. Resolve duplicates.

Click Save.

To log in using Google, follow these steps:

© N o » oA

Navigate to RingCentral Admin Portal.

Click Google.

If you have logged in before using your Google credentials, select your Google account from the
login page to log in automatically.

OR

If this is your first time logging in, click Use another account on the Sign in with Google window.

Enter your Google email address or phone number.

Click Next.

Enter your password.

Click Next to navigate to a page requesting access to your Google account.
Click Allow to finish logging in to your online account.

11
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RingCentra

Single sign-on

Single Sign-on allows employees in a company to access multiple applications with one set of credentials.
You can work with RingCentral Customer Support to set up Single Sign-on for your RingCentral services, or
you can set it up by yourself.

On Windows-based systems, Single-Sign-on supports the optional use of your company’s Kerberos network
authentication service to authenticate clients.

RingCentral also integrates with Google SSO, which allows G Suite customers to use the Google SSO service
(offered as part of G Suite IDaaS) to sign in to RingCentral. Google lists RingCentral as an approved SSO app
in their SAML apps catalog. As described here, you can configure RingCentral for SSO in the G Suite Admin
Console and configure the RingCentral SSO.

To log in using single sign-on, follow these steps:

1. Click the More tab from the Admin Portal.
2. Onthe left-hand side, click Security and Compliance.
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3. Click Single Sign-on.
4. Choose an option to set up SSO:
a. Setup SSO by yourself: Use the self-service Ul to configure the Service Provider (SP)
settings. Perform the steps in Set up Single Sign-On by Yourself.
b. Contact Customer Support: Use RingCentral Customer Support to configure the Service
Provider (SP) settings. Click the View Detail link, and perform the steps in Contact Support
to Enable SSO.

Note: Available for RingCentral Premium and Ultimate users only.

B By

Account Validation

Account Validation is a security feature that helps protect against fraudulent activity on your account, by
prompting for a security validation code when you log in from a new or unrecognized computer.
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When you log in as an administrator, you can access the Admin Portal for admin-only tools and configuration
of account-wide phone system settings. You can access your individual account overview and settings from
the My Extension page. At the top of the screen, hover over Admin Portal and click My Extension to switch to
your individual user homepage.

Admin Portal

From the Admin Portal, admins can see admin-only tools:

e The Home tab contains shortcuts for commonly used functions. You can also access several tutorial
videos from this page. Additionally, you can click on a link to access the App Gallery and Developer
Portal, with quick links to integrate Google, Office 365, and Salesforce.

e The Users tab allows you to view and manage users, and edit user permissions.

e ThePhone System tab houses all of the main settings for the entire phone system. Here, you have
Company Info, Phone Numbers, Auto-Receptionist, Groups, Phones & Devices, and Emergency Calling.

e The Meetings tab is where you can see information and configure settings related to your meetings.
Here, you have Recording Management, Rooms, Webinar Settings, Meetings Settings, H.323/SIP Room
Connector, Downloads, and Video Service.

e The Reports tab contains the Call Log, Meetings Reports, and Analytics.

e TheBilling tab displays information about your account, including Service Plan, Licenses & Inventory,
Usage, Calling Rates, Purchase, Meetings, and Device Orders.

e The More tab has more setup options, including Service Console, Account Settings, Security and
Compliance, and Apps and Resources.

e Inaddition, you can see shortcuts to edit settings for Company, Users, Phone Numbers, Phones &
Devices, Groups, and Billing.
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My Extension

When you switch to the My Extension page, you can see the standard user settings view of Overview,
Messages, Call Log, Contacts, Settings, and More. Click on Settings to access your individual settings. The My
Extension tab houses the same settings as a regular user has.
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Enterprise Portal

Federated accounts management is done with Enterprise Portal, which allows administrators to provision,
manage, and search across multiple Ringcentral accounts configured with Federation. This feature makes
administration easier for very large accounts and companies with multiple accounts by consolidating
management into a single view.

Enabling Enterprise Portal

The Enterprise Portal is not enabled by default in an existing federation. One of the users in federation has
to become the first Enterprise Super Admin, so that this user can go to the Enterprise Portal and share
access to other Enterprise admins.

To enable the Enterprise Portal and assign the first admin:

From the Admin Portal, click the Accounts tab at the top left.
Click the Enable button next to Enterprise Portal.

Browse or search, then select the user.

Click Save.

Db e

Accessing Enterprise Portal

The Enterprise Portal is accessible via RingCentral Admin Portal. If you have access to Enterprise Portal, it
will be the default landing page after login. To access accounts quickly, click Enterprise Portal at the top
right and click the name of the account.

Searching for accounts

The Federation name is at the top left of the page. To search for an account:

1. Select of the following categories:

e Users

e Numbers
e Groups

e |VRs

e Sites

2. Typeinthe name, phone number, extension number, email, etc., in the search field.
3. Click the searchicon.

The search results appear at the bottom of the page and you can further refine your search by choosing an
option from the dropdown menus.
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Adding admins to federated accounts

Click the Admins tab at the top left.

Click the + Add button. The Add Admin window appears.

Browse or search, then select the user(s) you'd like to add as admin(s). Click Next.
Under Copy Access From, select a user to copy their existing admin access.

OR

>R

Select an option under Enterprise Portal Role to assign this role to the new admin/s.

L

Assign the account you’d like them to have access to.
6. Click Add

Managing Enterprise admins

You can modify an admin’s access to the Enterprise Portal or remove their access to it.

1. Click the Admins tab at the top left.
2. Click the three-dot More icon under Actions.
3. Select Edit access or Remove.

18
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Product help

The user interface provides in-product help about the most frequently used features to help you gain quick
understanding of the features. Help includes:

e Tooltip: Icons that display in-product help text to help you successfully configure the feature.
e Learn More: Links that navigate to relevant Knowledge Base articles on the RingCentral support
portal for more detailed feature information.
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Audio conference

RingCentral customers can set up, host, and join conference calls anytime, anywhere. Click the circles
Conference icon in the upper right-hand side of your online account to get started.

Each customer receives a conference bridge number, and each user on the phone system gets his or her own
host and participant access code so that you and your team can hold independent conferences at any time.

You can also add an international dial-in number to the invitation. Click the Select button, and then check
the countries to be included from the list.

Each conference call can include up to 1000 attendees, enabling you to hold large meetings and broadcasts.

Launching the conferencing app

To launch the conferencing app, click the circles Conference icon to view and set the following:

1. Click the circles Conference icon within the App launcher.

2. A window will appear with conference numbers and settings.

a.
b.
C.

View the Dial-in number

View Host and Participant codes

If you have international participants, click on Select under International Dial-In Numbers.
Select international dial-in numbers. Click Done

Check the box next to Enable join before host to allow participants to start a conference
call without a host.

Click View under Conference Commands to view the touch-tone dial pad keys you can use
during your conference call.

Click Invite with Email to open an email with pre-populated conference details. Enter
participant details and send.
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Conference commands

For the Conferencing feature, the host and participants have the same conference bridge number to dial in
to, but their call control depends on the access codes that they will use.

e The Host has full call control and can access the conference commands shown.
e Participants have limited control of the conference commands.

The commands are displayed with the conferencing dial-in information.
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RingOut

RingOut enables one-touch calling from any phone or internet-enabled computer, allowing you to make calls
using your business caller ID from any location, such as a hotel room. The RingOut icon is located in the App
launcher in the upper right of every online account page.

1. Click the App launcher next to your profile icon in the upper right-hand side and select RingOut.
The RingOut dialer window will appear.

3. Inthe From field, enter the phone number of your current location (for example, your mobile
number).

4. Inthe To field, enter the number you want to call. Click the Clock button to choose from among
your recent calls, or the Add button to choose from your contact list.

5. Once you have entered From and To numbers, the Call button will turn green.

6. Check the box next to Prompt me to press 1 before connecting the call if you'd like the system to
confirm that you'd like to make the call before you are connected. When the system calls you, you
will hear "Hello. To connect this call, press one." This message protects you in case you mistyped your
own number, or if your voicemail picks up too quickly.

7. Click the Callicon. The system first calls you. When you answer (and press 1 as instructed if you've
selected this option), it then calls the other number and connects you.

- @
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FaxOut

To quickly send a fax from your online account, click the FaxOut icon located in the upper right corner. Fill in
the form with the recipient's fax number and cover page information, and attach a document.

FaxOut recognizes a wide variety of standard document types, including word processing and spreadsheet
and PDF documents. Send files from Dropbox, Box, or Google Drive with just a few clicks.

1. Click the App launcher next to your profile icon in the upper right-hand side and select the FaxOut
icon.
2. Enterupto 50 recipients.
a. Search and choose Contacts or Groups.
b. Click Insert.
3. Select your cover page and add a message.
4. Attach files from Dropbox, Box, Google Drive, or your computer and authorize RingCentral to
access your files (you have to do this only once).
a. Click Send Now.
OR
b. Toenable scheduling, select Enable and select a time for Send on.
c. Click Schedule.

@

s
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Home tab

The Home tab contains shortcuts for quick access to commonly used functions. Here, you will find links to
the following: ﬂ'l

Company =

Users Y

Phone Numbers

Phones & Devices L ] i3 ]

Groups

Billing . =

2
o

Click Support at the top right to access the RingCentral support site.

In the Tutorials section of the Home page, you can watch short helpful videos if you need help setting up
your phone system.

The Apps section on the upper right-hand side contains a link to the App Gallery, where you can view the
available apps you can integrate with your RingCentral phone system.

In the Resources section on the lower right-hand side, you can find external links to the following sites
relevant to your RingCentral account:

Community
Blog
Open a Web Case

RingCentral University
Service Status

What's New


https://support.ringcentral.com/
https://www.ringcentral.com/apps/
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RingCentral MVP | | Users
25

This section describes user setting actions that can be performed by administrators such as viewing
extensions, adding users, and editing user information. Let's take a closer look at these admin functions

Viewing users with extensions

1. Fromthe Admin Portal, click the Users tab.
2. Click Users with Extensions under User List.
3. Selectauser.
4. View or edit the settings for the selected user.
o =1 @
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Customizing columns in Users with Extensions list

From the Admin Portal, click the Users tab.

On the Users with Extensions page, click the three-dot More menu at the far right, then click
Customize Columns.

Check or uncheck the boxes for columns that you want to show or hide.

Click Save.

The following columns are available:

Status: User status. This column is always shown by default.
Name: User name. This column is always shown by default.
Number: User phone numbers.

Ext.: User extension.

Roles: User role with role scope.

Department: Department where User belongs to.

Email: User email.

Msg.: Number of User messages.

You can use the search function to easily find users. You can search by using first and/or last name, phone
number, extension, or email address. Click the filter icon to find users via their Status, Roles, or Department.

Note: If the Email column is hidden, you can still perform a search using your email address, or a partial A
email string. For example, if the email is user@ringcentral.com, you can search using user, user@, user@ring,
etc. However, searching for the email domain will not yield any results as you can’t perform a search based

on keywords belonging to the email address.

Viewing unassigned extensions

View unassigned extensions, assign an extension to a user, or delete an unused extension.

From the Admin Portal, select the Users tab.
Under User List, click Unassigned Extensions.
To assign the extension:
a. Select an extension.
b. Select a Setup Option, which includes Send invite, Activate by assigning credentials, and
Activate later. Enter information about the user that the extension will be assigned to.
c. Click Save or Save and Enable to add the user to your phone system.
To delete an unassigned extension:
a. Under Actions, click the three dot More icon at far right of the extension.
b. Click Delete to delete the extension.
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The user interface shown is for accounts with two or more users. Accounts with one user will see a different
interface.
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Adding users with devices

1. From the Admin Portal, navigate to Users > User List > Users with Extensions.

2. Click Add User. The Add Users window appears.
3. Select a Location from the dropdown list in Office User type, then click Select. By default, location is

based on the home country of the account.

RingCantral i .¢!
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4. Fillinthe basic information about the user. Require unique email IDs is checked by default. You can
uncheck it if you don’t want this option. Note that if this is unchecked, users cannot be invited by
email.

5. Ifyoud like to add more users, enter the number on the field provided, then click Add. You can add
up to 24 more users (25 users at a time). You may also click the duplicate icon at the far right to
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create a new row to add a user and retain the selection details, except for first name, last name, and
email.

6. Make a selection under Phone. Options include Inventory phone, Purchase phone, and Bring your own
device.

7. Ifyou selected Inventory phone, choose the desk phone that you'd like to assign to the user. If you
selected Purchase phone, choose the device you'd like to purchase. Use the search bar or set filters to
narrow down devices based on your specific requirements.

8. Click Select under Number. Select a number from the Number Inventory tab, which has the
numbers reserved for your account. Click Numbers to assign a new number. Select the State, Area
Code, and a number. Click Done. If you're an admin with purchasing permissions, you can add new
users and see the charges. If you don't have purchasing permissions, you'll be blocked and will need
to contact your billing admin for adding more licenses.

9. Select, edit, or add shipping address if you've selected Purchase Phone under Phone. You can ship
purchased devices to a single or multiple addresses.

10. Click Next.
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Setting up users

After the final step in Adding users with devices, you will see the following Setup options to onboard the

User:

e Send invite: Set up a user by sending a welcome email with an activation link.

e Activate by assigning credentials: Set up and activate a user by assigning credentials. No
welcome email will be sent.

e Activate later: Set up a user now but activate at a later time. No welcome email or
notifications will be sent.

Sending invite to a user

Select Send Invite under Setup options.

Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

Click Next. The Add Users - Confirm window appears.

Review the charges and check the acknowledgment box at the bottom.

Click Next.

Activating by assigning credentials to a user

1. Select Activate by assigning credentials under Setup Option.
2. Fillinthe info under Credential.

a. Password
b. Reenter Password
c. PIN
d. Reenter PIN
e. Security Question

f.  Answer
Note that these are all required fields.
Check the box for Temporary Password to prompt users to reset the password when they sign in for
the first time (optional).
Under Emergency Address, click Add beside the name of users with devices.
Fill in the info for the emergency address.
Read and understand the important notes about emergency calling service, check the box to
acknowledge, then click | Accept.
Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).
Click Next. If you click Next without doing Steps 4-6, there will be a prompt for Missing Emergency
Address. You may click Back to Add Emergency Address or Yes to continue without an emergency
address. If you don’t add an emergency address at this point, user(s) will be required to add their
emergency address when they log in to their RingCentral online account or RingCentral app.
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9. Review the charges and check the acknowledgment box at the bottom.
10. Click Next.

Activating user at a later time

1. Select Activate later under Setup Option.
Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

3. Click Next. The Add Users - Confirm window appears.

4. Review the charges and check the acknowledgement box at the bottom.

5. Click Next.

Adding free users (without a device and a number)
1. Fromthe Admin Portal, navigate to Users > User List > Users with Extensions.

2. Click Add User. The Add Users window appears.
3. Click Select in Mobile User type.
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4. Fillinthe basic information about the user. Require unique email IDs is checked by default. You can

uncheck it if you don’t want this option. Note that if this is unchecked, users cannot be invited by

email.

5. Ifyou'd like to add more users, enter the number on the field provided, then click Add. You can add

up to 24 more users (25 users at a time). You may also click the duplicate icon at the far right to
create a new row to add a user. Click Next.
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Setting up free users

After the final step in Adding users without devices, you will see the following setup options to onboard the

User:
e Send invite: Set up a user by sending a welcome email with an activation link.

e Activate by assigning credentials: Set up and activate a user by assigning credentials. No welcome

email will be sent.
e Activate later: Set up a user now but activate at a later time. No welcome email or notifications will

be sent.

Sending invite to a user

1. Select Send Invite under Setup Option.

2. Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

3. Click Submit.

Activating by assigning credentials to a user

1. Select Activate by assigning credentials under Setup Option.
2. Fillinthe info under Credential.
e Password

e Reenter Password
e PIN

e Reenter PIN

e Security Question
e Answer

Note that these are all required fields.
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3. Check the box for Temporary Password to prompt users to reset the password when they sign in for
the first time (optional).

4. Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

5. Click Submit.

Activating user at a later time

1. Select Activate later under Setup Option.

2. Click on Edit Role under Assigned Role if you want to change the permissions of the user. By
default, a user is set to have Standard User (International).

3. Click Submit.
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Deleting users and reassigning phone numbers

When deleting a user or extension assigned with a phone number, you specify whether to return the
number to your number inventory or reassign the number. When reassigning a number you can choose to

reassign to an extension, or to auto-receptionist, audio conferencing, or RingCentral Meetings. Reassigning

a number may require a license. If your account does not have a license, additional costs may apply.
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Click the Users tab from the Admin Portal.

Choose User List > Users With Extensions.

Click Delete opposite the disabled user extension. The Delete user window will appear.
In Phone Numbers, select Move to number inventory or Reassign.

In the Reassign number window, choose where to reassign the number.

Click Delete user and reassign number. You receive a message confirming the action.

When deleting multiple users, some numbers may not be reassigned to the number inventory. For example,
BYOC gateway numbers, forwarded numbers, and AU13 numbers may not be reassigned to the number

inventory and will be assigned by default to the auto-receptionist.
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Resetting and assigning a user

You can use the Reset and Assign feature to reset a former user’s settings and assign the extension to a new

user for quicker onboarding. Only disabled extensions have the option to be reset.

S e

7.

Click the Users tab from the Admin Portal. Users with Extensions is the default selection under
User List.

Click on the three-dot More icon at the far right of any entry with a red Disabled marker in the
Status column. Only disabled extensions have the option to be reset to a new user.

Select Reset and Assign. The Reset and Assign window will appear.

Check the boxes to the left of each entry that you want to activate for the user you are reassigning.
Click Next to access the Assign New User page.

Choose setup options, and enter the name and any other profile details you want to change for the
new user being assigned to the extension.

Click Reset and Assign.

A green notification banner confirms successful reassignment, along with a confirmation email to the admin.

You can also confirm results in Audit Trail.
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Copying and assigning existing user settings using an unassigned extension

1. From the Admin Portal, navigate to Users > User List > Users with Extensions.
2. Select the user you want to copy and click the More button under the Actions column at the far

right.
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3. Select Copy and Assign.
4. Onthe Copy and Assign window, choose Use unassigned extension. Click Next.

Copy and Assign

How do you want to add your new user?
(®) Use unassigned extension

() Use free or paid license

Cancel

5. Select one of the following tabs:
o Users with Devices: Select this option if you want to assign a device or a DigitalLine to the
new user. Select the device, then click Next.
o Users without Devices: Select this option if you don’'t want to assign a device or a
DigitalLine to the new user. Select the extension, then click Next.
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6. Select the settings you want to be copied. Any settings not selected will be set to default. Click Next.
7. Choose a Setup Option. Options include Send invite, Activate by assigning credentials, and Activate
later.

el e e
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8. Click Copy and Assign.
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Exporting a user list

Exporting a User List

You can export a list of users and extensions in Microsoft Excel file format. You can use this feature to create
a company directory or to perform an audit of users.

1. Click the Users tab from the Admin Portal.
2. Click Download User List to download a list of users and extensions for audit.
3. View the file in Microsoft Excel.
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Editing user information in bulk

You can efficiently make changes for multiple users in a single action. You export a template and add your
user information into the template for import to RingCentral. This feature is available for accounts with two
or more users and is not available to accounts that are using Active Directory.

To edit user information in bulk:

Click the Users tab from the Admin Portal.

Click the three-dot More icon on the right-hand side and click Edit User Information.
Click Download or enter an email address and click Send.

Fill out the template with the user information.

Click Browse and upload the user file.

S L e o

Confirm that you will overwrite all the user data.

Converting a virtual extension to a digital line

To convert a virtual extension to a digital line:

Click the Users tab from the Admin Portal.

Select a user to convert with a direct inward dialing (DID) number but without a digital line.
Click Phones & Numbers.

Click Phones.

Click Add Phone.

In the Add User Phones window:

A L e o

a. Select Domestic or International as the location.

b. Select a phone for the user on the Select Devices screen (this phone may be either a
softphone or a physical phone).

c. Click Existing Number on the Select Number screen. Select the DID (number) from the
user you are trying to convert.
Select your emergency address on the Add Emergency Address screen.
Complete the wizard.

Note: On the checkout screen, you will see a charge for the digital line and a credit for the DID. You will not
see a credit for virtual extensions that are Active User Extensions, as those are post-billed.
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Managing User Settings

Admins can edit the following user settings:
User Details

Phones & Numbers

Screening, Greeting & Hold Music
Call Handling & Forwarding
Messages

Outbound Caller ID

Outbound Fax Settings
Notifications

Administrators access and edit settings through the Users panel.

1. Fromthe Admin Portal, select the Users tab
2. Click the name of the user
3. Onthe user settings pane
o Select a category to edit (for example, Outbound Calls/Faxes)

Under Outbound Calls/Faxes, click the category to edit (Caller ID or Fax Settings)
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User details

Click on User Details to view and edit the selected user’s information. From this menu, you can edit the role
assigned to a user, as well as a user’s extension, name, recording, phone numbers, email address, job title,
department, hours, password, and regional settings. You can also manage the single sign-on policy for your

users here.

Managing single sign-on policy

Admins can manage the single sign-on (SSO) policy at the user level. When SSO is enabled on the account, it
controls the SSO login for all users on the account.

When Enforce SSO is enabled on the account, a user-level setting will be available to provide exceptions for
users that admins would want to allow to use their RingCentral credentials for authentication. The user
extension setting for SSO option is turned on by default when Enforce SSO is enabled on the account level.

Admins can also enforce SSO at a later time for these users that have already set their RingCentral
credentials during onboarding.
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Before you can change the SSO policy at the user extension level, ensure first that you have configured the
SSO settings and have enabled the SSO service on your account. For more information, navigate to Single

sign-on.

To manage SSO policy at the user extension level:

1. Click the Users tab from the Admin Portal.
Click User List.

3. Search the name of the user or browser through the list of Users with Extensions. You can also use
the filter and search by Status, Roles, Department, and Sites. Click the name of the user.

4. Click User Details.

Click Settings & Permissions.

6. Check the box next to Enforce SSO under Single Sign-on.

b

Admins can also manage the SSO policy via templates. To learn more, navigate to Managing templates.
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Phones & Numbers

Click Phones & Numbers to view and edit the selected user’s phone numbers and phone settings. You can
add a direct number for this user, add a phone, download/activate apps, change presence and intercom

settings, and view and edit conference settings.
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Primary Number
Admins and users can set a direct number as a user’s primary number displayed across different endpoints,
namely Admin Portal, RingCentral desktop app, and RingCentral mobile app.

An admin with user management permissions would be able to set this on behalf of other users. A user
would be able to set this on their profile.

To set a user’s primary number:

Click the Users tab from the Admin Portal.

Click the name of the user whose primary number you want to set to under Users with Extensions.
Click Phones & Numbers.

Click Edit under Primary Number.

Select the number you want to set as a primary number.

Click Apply.
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Screening, Greeting & Hold Music

Click Screening, Greeting & Hold Music to view and edit the selected user’s greeting, call screening options,
connecting message, audio while connecting, hold music, and blocked call settings.
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Call Forwarding and Voicemail

Click Call Forwarding and Voicemail to view and edit the selected user’s call handling, call forwarding, ring
group, additional phones, ring pattern, incoming call, and call flip settings.

You can enable and disable call forward options on some equipment, such as Polycom®VVX®phones. The
ability to enable call forwarding on the phone hardware must be enabled in your account. Some limitations
apply:
e Ifthe call forward is configured on the phone hardware, the forwarding will not be indicated in the
RingCentral system.
e The Call Forward selection on the phone setup between multiple devices is restricted to run only
three times.
e Ifauserreceives an E911 callback, and Call Forward is enabled on the user’s phone, the configured
destination will receive the E911 call.
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Outbound Calls/Faxes

In the user settings pane, click the Outbound Calls/ Faxes tab to configure settings for caller ID and fax.

Outbound Caller ID

Click Caller ID to view and edit the selected user’s outbound caller ID numbers.
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Outbound Fax settings

Click Fax Settings to view and edit the selected user’s fax cover page settings and fax via email settings.
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Bulk adding or editing users

1. Loginasanadministrator to the RingCentral online account.
2. Fromthe Admin Portal, navigate to Users > User List > Users with Extensions.
3. Click Bulk User Update. This will open the Assign Users window.

i T —

4. Choose a Setup Option. Options include Send invite, Activate by assigning credentials, and Activate
later.

5. The option for Users require unique email IDs is checked by default. If you've selected Send invite
under Setup Option, you are unable to uncheck this box. If you've selected either Activate by
assigning credentials or Activate later, you can uncheck the Users require unique email IDs if you
don’'t want this option.

Note: If this is unchecked, users cannot be invited by email and you have to select another setup
option.

Select a File Format. Options include Excel Workbook (.xIs) and Excel Workbook (.xlsx).

Enter your email address in the Send Email to field, and click Send.

Click OK on the Alert window that says the template file is sent.

Check your email and download the template. Read the instructions carefully and fill out the

0 © N o

template with your users’ information. Save the file once you’re done.
10. Click Browse under Upload File. Locate the Excel file containing your users’ info, click Open, and
then click Upload.

Setting up users

After the final step in adding a user extension, you will see the following setup options to onboard the user.

e Send invite: Set up a user by sending a welcome email with an activation link.
e Activate by assigning credentials: Set up and activate a user by assigning credentials. No welcome
email will be sent.



RingCentral MVP | | Roles and permissions
53

e Activate later: Set up a user now, but activate at a later time. No welcome email or notifications will

be sent.

Activating by assigning credentials to a user

1. Select Activate by assigning credentials under Setup Option.
2. Fillinthe info under Credential:

Password
Reenter Password
PIN

Reenter PIN
Security Question
Answer

o O O O O O

Note that these are all required fields.

3. Check the box for Temporary Password to prompt users to reset the password when they sign in for
the first time (optional).
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Roles and permissions enforce your company security policy by providing flexible, role-based access to your
RingCentral phone system. You can delegate access to certain areas without giving full admin access, or by
retaining control over certain areas. You can use templates and bulk upload options to efficiently apply roles
among Users across an organization.

Predefined roles
You can grant access privileges by assigning users one of the seven predefined roles:

e Super Admin: Complete system administrator-level access.

e Phone System Admin: Phone System settings access plus full access to user-level settings.

e Billing Admin: Full access to billing functions, user-level settings, international dialing, and some
analytics features.

e User Admin: Full access to user administration (self and others), international dialing, and system
features/apps.

e Manager: Provide users with all capabilities of Standard (International) along with access to key
functions such as Reports and Company Call Log.

e Standard (International): User level access with international dialing access.

e Standard: User level access without international dialing access.

Note: Predefined roles cannot be modified.

Custom roles

You can create custom roles to meet your business needs. When creating a custom role you select an existing role as a
starting point, and select permissions to be assigned to the role. To create a custom role, click New Role.

Note: This feature is available only to RingCentral MVP Premium and Ultimate with two or more users in
the US, Canada, and UK.

Assigning users to arole
To assign users to a role: From the Admin Portal, select the Users tab.

Click Roles.

Select one of the roles to assign users.

Click the Assigned Users tab to view the users currently assigned to the selected role.
Click Assign User. A list of users and their currently assigned roles is displayed.

Select the users to assign to the role.

Click Assign.

S e i
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The users’ roles are assigned and displayed in the Users list assignments are displayed in the Users list.

Note: The New Role option is available for MVP Premium and Ultimate users only.
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Modifying a user’s role

You can modify a user’s role by editing the user’s page.

Click the Users tab from the Admin Portal.
Click the user whose role you will modify.
Click User Details.

Click Settings & Permissions.

Click the Edit button under Roles.

Select the role.

Click Save.
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Creating anew role
To create a new, custom role:

Click the Users tab from the Admin Portal.

Click the Roles panel.

Click New Role.

Select arole to use as a template, or starting point, then click Next. The Create New Role window

Db e

appears.

L

Enter the Name and Description for the new role, then click Next.

o

Set the permissions for the new role.
7. Click Create Role.

Note: This option is available for MVP Premium and Ultimate only.
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Setting a default role

For ease of use, you can create a custom role and then set that role as the default role assigned to all
newly-created users.

If you do not set a default role, all newly-created users are automatically set to the Standard (International)
role.

Create your custom role.
Click Users from the Admin Portal.

Click Roles.

Select the custom role you created.
Click Edit.

Click the checkbox Set as Default.
Click Save.

No v hALODdR

Note: You can also select one of the predefined roles to be the default role.
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A RingCentral User Group associates users based on organization hierarchy. A group is managed by a user
group manager who accesses and modifies group members' settings and views their call logs. The account
administrator controls who gets access to view or create user groups.

The account administrator creates multiple groups as required for your organization. A flat, non-nested
group structure is supported. Users may belong to multiple groups. For example, for a director with two
team managers (and their team members), you might create three user groups: one group for each of the
team managers, and an overall group for the director that includes all reporting members.

When a user is assigned to be a user group manager, the user automatically inherits certain permissions.
These permissions work in conjunction with the role assigned to the user in the Roles section of user
administration. You must ensure that the primary role has the correct permissions so that user access is
controlled when the user is given user group manager access.

Note: This feature is available for RingCentral MVP Premium and Ultimate only.

Hised Gk



RingCentral MVP | | User groups
60

The tasks involved in managing user groups include:

e Assigning Users to User Groups: The Templates section in user management allows the account
administrator to streamline the assignment of users to user groups. This assignment is performed in
the User Groups option in Templates.

e Viewing and modifying User Settings: The User Settings sections, accessed from the User List in
user management, allows the user group manager to view and modify the settings assigned to a
member of their group, including the roles and user groups in the User Details section.

e Accessing Reports for your group members: The Reports section helps admins and user group
managers optimize the phone system by presenting usage analysis and trending metricsin an
easy-to-read graphical format. When logged in as a user group manager, you can see your group
members’ data only.

Creating a user group

When you create a user group, you organize a group of users by adding members to the group and assigning
a group manager who can modify members’ settings and view their call logs. The manager must at minimum
have User Admin role and permission to access the group manager interface.

Click the Users tab from the Admin Portal.

Click User Groups. You will see a list of existing user groups if any.
Click Create (if no user groups exist), or click New Group.

Enter a Name and Description for the user group.

Click Next.
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6. Add members to the user group. Search by department or all departments, and check to select the
users.

7. Click Next.

8. Select a member of the user group to be the user group manager. (The manager must be a member
of the user group).

9. Click Done.

The user group is created, and a confirmation message is displayed. The user group’s name and manager are
displayed in the User Groups view.
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Editing or deleting a user group

To edit an existing user group:

Click the Users tab from the Admin Portal.

Click User Groups.

Select an existing group from the list.

On the Overview page, click Edit to change the name or description of the user group. To change
the manager of the user group, click Change, select a new manager, and click Done.

Click Save to save the group’s changes.

6. Onthe Members page, add or remove members from the group as needed. To add a member click
Add Member, select members to be added, and click Add.

HPoODbd R

To delete a user group, click Delete and confirm the deletion. Deleting a group will result in members being

removed from the group and the group manager losing some privileges.
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RingCentral Templates will save you time and repetitive manual effort by streamlining your administrative
routine. There are two types of templates, one for user settings and another for specifying call handling
rules. Create a template and apply it to users as you need.

Creating a template for user settings

To create a template for user settings, follow these steps:

Click the Users tab from the Admin Portal.
Click Templates > User Settings.

Click Add User Settings Template.

Enter a New Template Name.

Click Save.
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6. Select atemplate from the left pane. You see options you can set for this template in the right panel,
grouped into categories of settings for Inbound and Outbound calling and Notifications. For each
group of settings, you can specify whether the settings override each users’ settings by checking
Override User Settings.

7. Configure Template Information settings. Under New Template Name, edit the name of your
template and see the last time it was modified and when it was created.

8. Configure User Details settings:

a. Regional Settings: Select regional settings for users such as time zone and time format.

b. User Hours: Set user hours to 24 hours or specify hours.

c. Roles: Select the role to be applied to the users. Roles give admins the ability to control
what users can do within the system. Arole is a collection of permissions that could be
based on a job function.

User Groups: Select the user groups where the user is to have a membership.

e. Site: Select site (applicable to multi-site accounts).

f. Confirmation Message: Specify how long the confirmation message will appear after a
successful operation is finished. You have the option to disable this feature.

g. JobTitle: Specify the job title.

h. Single-Sign on: Enforce SSO for users on the account.

i. Video Service: Select the meetings service you want to use in your web portal, RingCentral
app, and integrations.

j-  Receive Communications from RingCentral: Select if users receive voicemail messages
from RingCentral on product education.
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9. Configure Phones settings.

Appearance: Select extensions to display on desk phones and softphones.
Permissions: Select users permitted to answer calls of the other extensions.
Emergency Address: Provide a physical address for first responders.

oo oo

Bandwidth Settings: To improve the quality of your calls, you can set how much network
bandwidth to use for calls:
e High Bandwidth - gives you better sound quality but calls can become choppy when
it's not available.
e [ow Bandwidth - gives you lower sound quality but ensures no interruptions during
your conversation.
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10. Configure Screen, Greeting, and Hold Music settings.

a. User Greeting: Turn on this option when you want the system to answer the call with a
recorded welcome message, so callers know they've reached the right person. This is not a
personal voicemail announcement.

b. Call Screening: Turn on this option when you want callers to announce their name before
continuing to connect the call. This option lets you identify the caller so you can pick up the
call immediately. After turning on this option, go to Call Forwarding and Voicemail >
Settings > Incoming Call Information to set your preferences.

c. Connecting Message: Set a recorded message you want callers to hear to let them know
the call will now be transferred to your line.

d. Audio While Connecting: Incoming callers will hear the music selection that is configured
with this setting. The music selection callers will hear when they are placed on hold can be
set in the Hold music selection. Note that the Audio While Connecting setting is applied on
arule basis, whereas the Hold Music setting is applied for all calls.

e. Hold Music: Turn on this option when you want callers to hear music whenever you put a
call on hold.



RingCentral MVP | Admin Guide | Templates

(] Cwaimide Uiser Saiings

B Enibli

Dertpis® Mlesssage "Flease hobkd whils | iy
0 ORI R

[] Gwverice Liser Saitngs
Hgld Musiz (7]

[
Wi Aogeipic

3 e L

] Cwaeride Liser Saiings:

[ Eraibie

[ ‘COrepimics Usa Sedtings

|

Biigiay Wiils Conneoting
B Eratie
Mhusis | Al
3 Q000 0000 W e—

Mugic or Fangione Collas will hear whils
[ e |

=]

[7] Crepmicin Ut Sedtings

68



RingCentral MVP | Admin Guide | Templates
69

11. Configure Call Forwarding and Voicemail settings. Under Desktop & Mobile Apps, specify whether
to notify your Desktop and apps before forwarding the incoming call to your desk phones and
forwarding numbers, and specify a wait time.
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12. Configure Messages settings.

a. Take Messages: Allow or deny users to take voicemail messages; specify a default or custom
voicemail greeting.

Voicemail Greeting: Specify a default voicemail greeting.

Message Recipient: Select the recipient of voicemail messages.

This extension: Select users to be included as message recipients when applying a template.
Specific extension: Select an extension to be the recipient of voicemail messages.
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13. Click the Outbound tab to configure settings for outbound calls such as caller ID and fax settings.

a. Caller ID: Specify caller ID settings by phone or by feature. If you select Toll-Free number or
Blocked as your Default Caller ID for any of your endpoints/calling features, you can also
select an alternate local number to use in case we detect that your call will not go through.
b. Fax Settings: Specify fax settings including fax cover page information and settings for
faxes sent through email.
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14. Click the Notifications tab to configure the notifications settings. Select each of the following if you

want to be notified by email.

a. Voicemail Messages
b. Received Faxes
c. Missed Calls
d. FaxTransmission Results
e. Received Text Messages
15. Click Save.
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Creating a template for Call Handling settings

1. Click the Users tab from the Admin Portal.
2. Click Templates.
3. Click Call Handling.
4. Click Add Call Handling Template.
5. Enter aNew Template Name.
6. Click Next.
7. Specify the caller ID or date conditions that will trigger the application of this template.
8. Click Next.
9. Specify the action to take when incoming calls match this rule.
10. Click Save.
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Applying a template to users

There are several ways to apply a template to users.

Applying a template via Users List

Click the Users tab from the Admin Portal.

Select the number of users.

Click Apply Templates.

Select a template to apply.

Click Apply Template.

Click Continue to confirm that you are about to make settings changes for all the selected user(s).

S O o

This will overwrite any configuration the user might have done previously.
7.  Anemail will be sent to you when it's completed. You may choose to notify active users of the
change by email and also add more recipients. Click Apply Template.
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Applying a template via User Settings under Templates

1. GotoUsers > Templates > User Settings.
2. Click the more icon opposite the Template that needs to be applied to User/s and select Apply.

L
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Select the Users who should be assigned to the selected template on the Apply Template pop-up

window.

Click Apply.

Click Continue on the prompt to confirm that the template will be applied to the selected Users.

An email will be sent when the template application is complete. You can tick on the box to notify
only active users. You can also enter additional recipients in the box. Click Apply Template when
done.

Applying a template via User Details

AP Dbd e

Go to Users > User with Extensions.

Select a user to whom you want to apply a template.
Go to User Details > Settings & Permissions.

Click Apply under Template.
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5. Select a Template from the popup window.

6. Click Apply Template.

Managing the Phone System

The Phone System tab houses all of the main settings for your entire phone system. Here you will find

settings for:

Company Info

Phone Numbers
Auto-Receptionist
Multi-Level Auto-Receptionist
Groups

Phones & Devices

Emergency Calling

Automatic Location Updates
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Company Info

Your account may be a single-site account or may contain multiple sites when you have enabled RingCentral
Multi-Site Support. With a single-site account, the Company Info page displays the settings for your account,
including Company Address, Caller ID Name, and Directory Assistance. Select the appropriate tab to access
each section.

Managing Sites with Multi-Site Support

When you have enabled RingCentral Multi-Site Support, the user interface displays each of the configured
sites in your account and allows you to create a new site (by selecting New Site or Bulk Site Create) or edit
the information for any of your existing sites (by selecting the site from the list). Site filter controls are also

available from pages that contain site assets.
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Company address

78

Set your Company Address information for the default company name and your company address for a

Directory Listing (if available for your account).

Click Company Info.
Click Company Address.
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Click Save.
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Click the Phone System tab from the Admin Portal.

Enter your Company Name and Company Address with City, State, and Zip Code.
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Caller ID Name

Set your Company Caller ID to your company’s name so that your customers will know who is calling them.
This name, along with the phone number, is displayed to the called party whenever an outbound call is made
using the local number as the caller ID.

Click the Phone System tab from the Admin Portal.

Click Company Info.

Click Caller ID Name.

Enter your company name exactly the way you want it to appear on Caller ID displays, for local calls

made from your main company phone number. You can enter up to 15 characters.
5. Click Save.

O bdpR

Note: Outbound Caller ID cannot be set for an individual number or digital line. It is only available for local
numbers and not toll-free numbers.
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Directory Assistance

Directory Assistance is a free and convenient way to publish your business name, address, main number, and
main fax number to increase your company’s visibility in local directory assistance listings. For more
information about Directory Listing, see Directory Listing Frequently Asked Questions. To publish your
information:

Click the Phone System tab from the Admin Portal.
Click Company Info.

Click Directory Assistance.

Enter your listing information.

Click Next.

Check the box next to | agree to the terms of service.
Click Publish.

No s~ R

Note: Allow five business days for your listing to appear. Edit or delete your listing any time by following
these same steps.
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Phone Numbers

The Phone Numbers tab allows you to view your numbers by category of number, and add additional
numbers to your account.

The tabs contain these types of numbers:

All Numbers: Includes all numbers in your account.

Numbers in Use: Numbers currently assigned to an extension or a device.

Number Inventory: Numbers that are not assigned to a user extension or device.

Transferred and Vanity: Existing numbers that have been transferred, and vanity numbers to help

customers remember your business phone number.
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Adding company numbers

Each RingCentral number can function as a voice and fax line for incoming calls. This means that one number
can be used for both calls and faxing to maximize the use of your service.

1. Click the Phone System tab from the Admin Portal.
2. Click Phone Numbers.
3. Click All Numbers.
4. Click Add Number.
5. Select a Location and follow these instructions for the Number Type you choose:
e Local Number: Provide the State and Area Code. Select one or more numbers and click Add
Numbers.
e Toll-Free Number: Select a toll-free prefix. Note that there is a $30 one-time setup fee per
number if you select 800 as your toll-free prefix. Select one or more numbers and click Add
Numbers.
e Vanity Number: Enter a number that helps customers remember your business phone
number. Click Search to check availability. Select a number and click Add Numbers.
6. Click Next.
7. Select Auto-Receptionist to assign the number as a company number.
8. Click Next.
9. Review any changes to your number plan. Check the acknowledgment box.
10. Click Next.
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Adding assigned numbers

Under Numbers in Use, you will see all of the numbers assigned to a user that has been set for your phone
system. From here, you can add a number.

Click the Phone System tab from the Admin Portal.
Click Phone Numbers.
Click Numbers in Use.
Click Add Number.
Select a Location and follow these instructions for the Number Type you choose:
e Local Number: Provide the State and Area Code. Select one or more numbers and click Add

vihwbdpe

Numbers.

e Toll-Free Number: Select a toll-free prefix. Note that there is a $30 one-time setup fee per
number if you select 800 as your toll-free prefix. Select one or more numbers and click Add
Numbers.

e Vanity Number: Enter a number that helps customers remember your business phone
number. Click Search to check availability. Select a number and click Add Numbers.

Click Next.

Select Extension to assign the number, and then select the extension you want to assign it to.
Click Next.

. Review any changes to your number plan. Check the acknowledgment box.

10. Click Next.
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Forwarding a number

You can maintain your phone number with your current provider and forward calls automatically to your
RingCentral account.

No oA~ R

o o

Click the Phone System tab from the Admin Portal.

Click Phone Numbers.

Click All Numbers.

Click the more three-dot icon beside Add Number.

Select Forward Number.

Enter your existing phone number and click Next.

Select where you would want to forward the calls to. The options are Auto-Receptionist and
Extension. If you selected Extension, select an extension.

Click Next.

Review the information about ordering Busy Call Handling and No Answer Call Handling from your
local telephone company, and the local telephone company charges.

10. Click Done.
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Naming phone numbers

Admins can assign phone numbers with “nicknames” for reference or organization purposes. This allows
them to efficiently search by their name in the Phone Numbers tab.

Click the Phone System tab from the Admin Portal.
Click Phone Numbers.

Click Numbers in Use.

Click the number that you want to assign a name to.
Enter a name on the Name field.

Click Save.

S e o

88



RingCentral MVP | | Phone System
89

Viewing unassigned numbers

Under Number Inventory, you will see all the numbers that are not assigned to a user extension or a device.

Click the Phone System tab from the Admin Portal.
Click Phone Numbers.

Click Number Inventory.

Filter the numbers by Locations and Sites.

Click a number to see more information.

LAREIE S

You can view phone properties in the Phones & Devices tab.
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You can see unassigned numbers that have a device under All Numbers and Numbers in Use by filtering
them.

Click the Phone System tab from the Admin Portal.
Click Phone Numbers.

Click All Number or Numbers in Use.

Click the filter icon beside the search bar.

Click Types.

Select Unassigned Extension.
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Viewing transferred and vanity numbers

Under Transferred and Vanity, you will see the numbers that you have transferred, as well as vanity
numbers.

1. Click the Phone System tab from the Admin Portal.
Click Phone Numbers.

3. Click Transferred and Vanity. Select Transfer Orders, International Number Orders, or Pending
Vanity Numbers. Click a number to see more details.

4. To transfer a number to RingCentral, select Transfer Numbers under Transfer Orders. Select US or
US territory Local Number, US or US territory Toll-Free Number, Canadian Number, or
International Number. Complete the process.
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Create your own auto-receptionist for your phone system. Customize your options for effective call
management. For example, choose your company hours, set your company greeting, define rules for call
handling, and more.

Note: The auto-receptionist defaults to IVR Mode: single level. You can change the IVR mode to multi-level
for amore intricate IVR menu. Once the settings are changed to multi-level IVR mode, options are slightly
different.

When you have enabled RingCentral Multi-Site Support, the user interface displays the auto-receptionist
for each of the sites’ auto-receptionist with individual business hours, custom rules, IVR settings, and

regional settings.
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Company business hours

Customize your company's business hours. You can specify the opening and closing time for each day of the
week or select 24 hours. This establishes the settings for the Business Hours and After Hours tabs in other

settings areas (such as call queue settings and user settings).

1. Click the Phone System tab from the Admin Portal.
2. Click Auto-Receptionist.

3. Click General Settings.

4. Select Company Hours.

5. Setyour Company Hours to:

a. 24 hours to have incoming calls handled the same way all the time.

b. Custom hours lets you specify hours for each day of the week. You can also set separate
call-handling rules and greetings for Business Hours and After Hours. To copy hours from
one day to all weekdays, or to the entire week, select Copy to Weekdays or Copy to All
Days.

6. Click Save.

Note: If you have global companies, select first which level to which the site you're configuring should belong
to by selecting from the Multi-level dropdown menu in the upper right.
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Company call handling

Company Call Handling provides call handling options for single-level IVR accounts. This controls what
callers hear when they dial your company number/s during business or after hours. You can configure
separate settings for business hours and after hours.

There is also an option for accounts with a single-level IVR setting to forward all company calls when
needed, such as during holidays, manual closures, or emergencies. Incoming calls can be forwarded to a
company greeting, announcement, voicemail, coworker, call queue, or shared line. You can set the time
period when the incoming calls should be forwarded.

1. From the Admin Portal, navigate to Phone System > Auto-Receptionist > General Settings.
Click IVR Settings. Company Call Handling appears.
3. Select Forward all company calls if you want this option, and specify
a.  Where calls should be forwarded.
b. Start and end times for forwarding.
c. Review the company greeting and click Save.
4. Under Business Hours and After Hours, select one of the following:

e Company Greeting: Sends the call to company greeting. Callers may hear options where
they want to be connected to.

User Extension: Sends the call to a User extension.

Call Queue Group: Sends the call to a Call Queue Group.

Shared Line: Sends the call to a Shared Line.

Voicemail: Sends the call to a Message-only Extension.

Announcement: Sends the call to an Announcement-only Extension.

Limited Extension: Sends the call to a Limited Extension.

Company greeting

From the Admin Portal, navigate to Phone System > Auto-Receptionist > General Settings.
Click IVR Settings. Company Call Handling appears.

Under Business Hours and After Hours, select Company Greeting.

Click Edit under Play company greeting. The Company Hours Greeting window will appear.
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5. For Set Greeting, select:
e Default: Plays system default greeting.
e Custom: Plays your custom recording. Select one of the following to record your greeting:
o Phone: Choose a phone number from the dropdown menu if you have saved
numbers or select Enter a new number and type the phone number in the Call me at
field. Click the Call Now button and RingCentral will call you to record your
greeting.
o Computer Microphone: Click Allow if RingCentral asks to use your microphone.
The Microphone Test and Record settings will appear. When ready, click the red
record button to record your greeting through your computer microphone. Stop
the recording and listen to the playback. Click the arrow up to upload your
recording.
o Importing: Browse for a WAV or MP3 file you want to use. Click Open.
6. Under If Caller Enters no Action, select Connect to operator or Disconnect.
7. Click Done.
8. Click Save.
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Regional Settings

Set your timezone in Regional Settings. Typically, your timezone is linked to the area code of your main
company number. For example, for area code 650 (California), the time zone defaults to Pacific Time. If you
are not physically located in your area code, you may want to change your timezone. You can also set the
following Regional Settings:

Time Zone

Time Format

Home Country Code
User Language
Greetings Language

Regional Format
To configure regional settings:

Click the Phone System tab from the Admin Portal.
Click Auto-Receptionist.

Click General Settings.

Click Regional Settings.

Under Regional Settings, select options:

ko bdE

Select your Time Zone.

Select Time Format as 12hr or 24hr.

Select your Home Country Code.

Select your User Language as the default language used for all accounts and notifications.
Select the Greetings Language as the default language you want to use for phone greetings.
Select Regional Format as the format used to show date, time, currency, and other

numbers.
6. Click Save.



RingCentral MVP | Admin Guide | Auto-Receptionist

100

Eige L
0 o Sr—
B s SE—

I HI e o

B P T—

A e ]

B e tmemma w0 ] B,

Hharm Vi Fl—nh—‘ﬂ-—‘l Fiapmy - ] L]

b

Eo b

HLE

M Pid  Hoen S Pal W

. Owpwy-awa (e

-

Tng s e _
'P-_
!if-fd-li— s il ik D

[ P —
v e 11
i | —
s i

ey pewm e e e Ly
Taw Py

LR LT, R L
iam [ wepogn
g 8 0y

e
e T

T




RingCentral MVP | | Auto-Receptionist
101

Dial-by-name directory

The Dial-by-Name section allows you to enable callers to search your phone system by users’ first or last
names using their dial pad keys. To Configure the Dial-By-Name Directory:

1. Click the Phone System tab from the Admin Portal.
2. Click Auto-Receptionist.
3. Click General Settings.
4. Click Dial-by-Name Directory.
5. Under Dial-by-Name Directory, set the slider button to On. Select options for dialing by name:
e By default, all extensions are included in the directory.
e Tolimit included extensions, under Extensions in Directory, click Edit. Then select the
extensions you want to include in the Dial-by-Name Directory.
6. Click Done.
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Operator extension

Select the extension to use for the operator, which receives all calls and messages by default. The operator
extensionis 101 by default.

Note: Use caution when changing this setting, as the operator is the default call recipient when no other
extension is dialed.

To reset the Operator Extension:

Click the Phone System tab from the Admin Portal.

Click Auto-Receptionist.

Click General Settings.

Click IVR Settings.

Under General IVR Settings, click Select Extension. The Operator Extension window appears.
Select the extension for the operator.

Click Done.

Click Save.

© No AW PR

The assigned Operator Extension will now appear under IVR Settings heading.
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Zerodialing

Directly routes calls to a specified destination. Three options let you designate the call handling when the
caller dials zero within your IVR.

To set zero dialing:

Click the Phone System tab from the Admin Portal.
Click Auto-Receptionist.
Click General Settings.
Click IVR Settings.
Scroll down and click Zero Dialing.
Select one of three options:
e Connect to Company Greeting.
e Do Nothing: the system ignores any ‘O’ dialed by the caller and continues uninterrupted.
This applies regardless of the number of times the caller dials ‘O’.
e Connect to Extension: choose from Operator or Specific Extension.
7. For multi-site accounts, you may configure different or multiple operators on a per-location basis.
8. Click Save.

S R

Note: When deleting an extension, a warning shows that if the extension is selected for zero dialing
connection, deleting the extension will result in zero dialings by callers to be connected to Company
Greeting.
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You can label phone numbers in a meaningful way to help identify locations or users in your system* Larger

businesses with multiple locations and advanced call handling rules might involve selecting from lists of

numbers. Many numbers may appear similar unless they are renamed. An admin can assign an alternative

name to a particular number using the following steps:

Click Phone Numbers.
Click Company.

oL R

Click Save.

Note: This option is available for RingCentral Ultimate users.

Click the Phone System tab from the Admin Portal.

- N

. 4 ==

Click the phone number to which you want to apply a label.
Enter the label text in the Name field. You can designate the kind of number by using Number Type.
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On-demand call recording

On-demand Call Recording makes it easy for RingCentral users to record calls they make or receive. When
you enable On-demand Call Recording, users can activate it by pressing *9 on their phone’s dial pad.

Note: State and federal laws require that your callers hear a call-recording notification before and after a
callis recorded. As an administrator, you need to ensure your company's call recording procedures comply
with federal and state laws; RingCentral is not responsible for your company’s compliance.

Choosing an on-demand call recording announcement
This explains how to select a particular recording announcement once On-demand call recording is enabled.

Click the Phone System tab from the Admin Portal.
Select Auto-Receptionist.
Click General Settings.
Click Call Recording. Slide the button on for On-demand Call Recording.
Click Edit to change:
a. Announcement on Start
e Click Set Greeting and choose Default or Custom.
e Click View In, choose the language for viewing the message text.
b. Announcement on Stop
e Click Set Greeting and choose Default or Custom.
e Click View in, choose the language for viewing the message text.
6. Click Done.
7. Click Save.
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Enabling on-demand call recording announcement

oA wbd e

Click the Phone System tab from the Admin Portal.

Click Auto-Receptionist.

Click General Settings.

Click Call Recording.

Move the slider button to the right next to, Enable On-demand Call Recording.
Click Save.
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Interactive Voice Response (IVR)

In the RingCentral system, you can create a multi-level IVR as an additional option for the
Auto-Receptionist. It extends the Auto-Receptionist menu with more powerful and efficient call handling.

Multi-level IVR options

Single-location IVR example
A local dentist office provides services to both English- and Spanish-speaking customers. The dental office IT
Manager configures the phone routing system with identical prompts in two languages.

Multiple-location IVR example

A nationwide furniture retailer has five stores located in San Francisco, Chicago, New York, Dallas, and
Miami. The IT Manager sets up a toll-free number for the automated attendant system that can route
incoming calls to the proper stores in the entire retail chain.
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Multi-Level IVR, single location use case: bilingual dentist office
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Switching to multi-level IVR mode

As an option, you can change your Auto-Receptionist from a single-level to a multi-level IVR to serve users
at multiple locations or to provide callers with multilingual menus.

Click the Phone System tab from the Admin Portal.
Click Auto-Receptionist.
Click General Settings.
Click the Single Level button and select Multi-level. The Switch to Multi-level IVR window will
appear with a warning message. By switching to multi-level IVR mode, all of your company call
handling settings will be discarded.
5. Confirm that you wish to proceed.
Click Continue to confirm switching to multi-level IVR.
7. The Switch to Multi-level IVR window appears. Do one of the following:
e Enter atop-level menu in the Select the top level menu to connect to the search field.
e Select the button next to one of the listed Names.
8. Click Save.

bR

o

Because your call handling settings are discarded, you will need to reset them. Your IT department should
validate and test the IVR configuration to ensure the routing and prompts in a root menu work well before
connecting them to the Auto-Receptionist.
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Managing general IVR settings

When you have set multi-level IVR mode, you can see General IVR Settings from the Auto-Receptionist
menu. To set general IVR settings:

Click the Phone System tab from the Admin Portal.

1
2. Click Auto-Receptionist.
3. Click General Settings.
4. Select IVR Settings.
5. Scroll down to General IVR Settings.
6. Under General IVR Settings, select options:
a. Configure the actions for the general navigation keys. When callers press # (hash/ pound) or
* (star/asterisk), the following actions are available:
e Repeat menu greeting.
e Returntoroot menu.
e Return to previous menu.
b. If the caller enters no action after the prompt is played three times, the following actions
are available:
e Disconnect: The call will be disconnected.
e Connect to extension: The caller is routed to the extension you specify.
7. Click Save.
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IVR Editor

RingCentral provides additional IVR tools to help you create and manage your IVR Menus.
Auto-Receptionist consists of three parts that help you configure your IVR: IVR Menus, IVR Editor, Prompts
Library. Use the IVR tool to:

Configure IVR menus with the Visual IVR Editor
Import prompt recordings

Record prompts

Import and export XML files

Note: Any change on the IVR menu overwrites the imported XML file. It is suggested that you export and
save a new XML file after making changes.

Access the IVR Tool by using the following steps:

1. Click the Phone System tab from the Admin Portal.
2. Click Auto-Receptionist.
3. Click IVR Editor.
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IVR menus

RingCentral offers various tools to help manage and create IVR (interactive voice response) menus.
Administrators can add new IVR menus as shown in the following instructions, use the Visual IVR Editor, or

import an XML file.

Adding an IVR menu group

Click the Phone System tab from the Admin Portal.

Click Auto-Receptionist.

Click IVR Menus.

Click the New IVR Menu button. The Add IVR Menu window will appear.
Enter the Extension Number and Extension Name.

Click Save.

S e o

The new IVR Menu appears listed under IVR Menus.

Note: Available for MVP Premium and Ultimate users only.
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Configuring an IVR menu

After you have created an IVR Menu, you can now configure the Extension Info, Direct Numbers, Prompt,
and Call Handling.

Configuring extension info

After you select an existing IVR Menu, edit your extension number, name, or delete your menu.

1. Click the Phone System tab from the Admin Portal.
2. Click Auto-Receptionist.
3. Click IVR Menus.
4. Select an existing IVR Menu.
5. Enter the Extension Number, Extension Name, and set the Language.
e Click Add if you would like to add a Direct Number.
e If youwould like to delete this IVR menu, click Delete IVR Menu.
6. Click Save.
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Adding Key Presses

Before you can switch your company call handling to multi-level IVR, you must first add and set-up your IVR
menu. The Auto-Receptionist greets callers with a recorded message when they call your company. Your

Auto- Receptionist is initially set to play a default greeting with your company name using text-to-speech

technology. You can set a custom greeting by recording through your phone or computer or by uploading a
sound file. You can also connect the Auto-Receptionist calls directly to an extension of your choice.

w N

N o » oA

9

Click the Phone System tab from the Admin Portal.
Click Auto-Receptionist.
Click IVR Menus. To add a new IVR Menu, click New IVR Menu, fill in the fields for Extension
Number and Extension Name, and then click Save.
Click Key Presses.
Click Add Key. The Key Press Assignment window appears.
Set the Key Press.
Select a Connect to action:
a. Transfer to voicemail of
b. Connect to Dial-by-name directory
c. External transfer
Select to whom the setting will apply:
a. Allextensions
b. Users
c. IVRmenu
d. Others
e. Groups
Select Users.

10. Click Save.
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Adding a direct number
1. Click the Phone System tab from the Admin Portal.
2. Click Auto-Receptionist.
3. Click IVR Menus.
4. Click an existing IVR Menu.
5. Click Add under Direct Number.
6. Select aLocation and follow these instructions for the Number Type you choose:
a. Local Number: Provide the State and Area Code. Select one or more numbers.
b. Toll-Free Number: Select Toll-Free Number and select a Toll-Free prefix. Select one or more
numbers.
c. Vanity Number: Select Vanity. Enter a number that helps customers remember your

business phone number. Click Search to check availability. Select a number.

7. Click Add Numbers.
8. Click Next when finished choosing your number.
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Visual IVR Editor

The Visual IVR Editor lets you configure your Multi-level IVR using an easy-to-use graphical interface. Add
menus and assign to extensions with just a few clicks. To launch the visual editor, follow these steps:

>R
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Click the Phone System tab from the Admin Portal.

Click Auto-Receptionist.

Click IVR Editor.

Click Launch Visual IVR Editor. The Visual IVR Editor opens in a new browser tab.
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Creating a new IVR menu or open an existing IVR menu

Follow these steps to create a new IVR menu with the visual editor.

1.

In the new tab, you will see your Visual IVR Editor. On this page, you will have a New Tree waiting to
be created. You have the option to create a new IVR from this screen, or open an existing IVR and
edit it in the Visual IVR Editor.

a. Inthe upper-left corner of the screen you have icons for Open Existing Menu, Save,

Validate, and Clear Workspace.

In the upper-right corner, you have a search bar, an information dropdown menu with options for
Take a Tour and Learn More, and when you are viewing an IVR menu, you will see zoom in and out
buttons.
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3. Click the Phone icon to start a new tree.
4. Your new tree will be automatically assigned a name and extension number.

5. Click the name or extension number to edit the text field and enter your preferred name and
extension. Press enter when you are finished and the title will change automatically.

6. Hover over your new IVR menu to see more options.

7. Click “+” to add sub-items to your tree. Sub-items include:

a.

-0 a0 o

New Menu: Create a new IVR menu as an option within your tree.

Existing Menu: Choose an existing IVR menu from a different IVR tree.

External Transfer: Include an external number in your tree.

Directory: Attach your company’s dial-by-name directory to your tree.

Voicemail: Give the option to leave a voicemail.
Extension: Add a specific extension to your tree.
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9.

10.
11
12.
13.
14.

| Auto-Receptionist
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As you add sub-items to your tree, they will appear in the Visual IVR Editor. Once you have added
your items to your menu, hover over an item to edit it and see more options. For some items you will
see a“+” and “...” and other items will only have the trash canicon.
Click the IVR name and extension text fields to edit them.

Click “+” to add sub-items to your tree.
Click “...” to open the menu for Settings, Duplicate, and Delete.

Click Settings to edit your IVR Menu settings just as you would edit them in the IVR Group settings.
Click Delete to delete this item.

To save the configuration, click Save at the top left corner.
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Editing an existing IVR menu with the visual IVR editor

0V ONOUAODN R

Click the Phone System tab from the Admin Portal.

Click Auto-Receptionist.

Click IVR Editor.

Launch the Visual Editor, then click the Open Existing Menu icon.
Click on an existing menu to see a preview of the menu.

Click Open to be able to edit the menu in the Visual IVR Editor.
After editing your menu, click the Validate icon.

to check your IVR menu.

Click the Save icon once you are done editing to save your IVR.
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Prompt recordings
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Prompt recordings guide callers with instructions on keys to press. Prompts can be pre-uploaded and saved
to the Prompts Library, which you can then set up as prompts using the IVR Tool.

There are two prompt modes: audio and text-to-speech.

Audio prompts are voice recorded

Text-to-speech prompts are written by you, then RingCentral’s automated system reads the prompt

to your callers.

Note: An IVR menu can function independently from the Auto-Receptionist, so it does not have to be set up
for an Auto-Receptionist greeting.

Recording an audio prompt

oAb R

Click the Phone System tab from the Admin Portal.

Click Auto-Receptionist.

Click Prompts Library.

Click Record Prompts. The Record Prompt window will appear.

Enter a name for your prompt in the Prompt Name field.

Select one of these prompt methods and follow the on-screen instructions:
e Phone
e Computer Microphone

Follow the remaining on-screen instructions to record your prompt.

F
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Selecting audio prompt mode

1. Click the Phone System tab from the Admin Portal.
2. Click Auto-Receptionist.
3. Click IVR Menus.
4,
5. Click Prompt.
6. Under Prompt mode, select the button next to Audio.
7.
prompts.
8. Select the button next to the prompt you'd like to set.
9. Click Select.
10. Click Save.

| Auto-Receptionist

123

Select an existing IVR Menu. The Extension Info will appear.

Click Select under Select Prompt. The Select Prompt window appears with a list of pre-uploaded

You can listen to your new prompt by dialing into the extension.
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Selecting text-to-speech prompt mode

RingCentral's text-to-speech utility converts the text greeting you typed into a voice file and saves it to the
IVR Prompt Library. Set an IVR prompt using text-to-speech. The text you enter must contain only letters,
digits, space, commas, and periods. No special symbols. Use the words “hash” or “pound” or “star” instead of
“#” or “*” if needed.

To set up a text-to-speech prompt for an IVR menu:

Click the Phone System tab from the Admin Portal.

Click Auto-Receptionist.

Click IVR Menus.

Select an existing IVR Menu. The Extension Info will appear.

Click Prompt.

Under Prompt mode, select the button next to Text to speech.

In the box for Text, type your desired greeting and connection instructions for your callers.
Click Save.
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Importing or exporting XML files

In the XML section, you can import and export XML files for your IVR. Your IVR Menus are validated by
RingCentral once you import an XML file.

Downloading a sample XML file

Click the Phone System tab from the Admin Portal.
Click Auto-Receptionist.
Click IVR Editor. The XML Editor displays.
Under Download Sample IVR XML Files,
e Click Single Level IVR.
OR
e Click Multi-level IVR.

DR

The sample XML file is downloaded to your browser.
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Exporting an XML file

Click the Phone System tab from the Admin Portal.

Click Auto-Receptionist.

Click IVR Editor. The XML Editor displays.

Under Export IVR XML File, click Export. The sample XML file is exported to your browser.
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Importing an XML file

Click the Phone System tab from the Admin Portal.

Click Auto-Receptionist.

Click IVR Editor. The XML Editor displays.

Under Import XML file, click Import to browse and locate the XML file. Then click Import.

PO bdpe

RingCentral detects configuration issues as soon as you click Import. You can manually fix the errors in the
XML file and upload it again or you can click Accept and Continue to manually fix the errors using your
RingCentral Online account.
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Recording greetings and messages

Several tasks require admins to record messages or greetings for your RingCentral system. These steps
explain how to do the following:

e Record Over the Phone
e Record Using the Computer Microphone
e Importa WAV or MP3file

Importing a WAV file for your IVR prompt

In the Prompts section, you can import or record your IVR prompts and edit prompts that have already been
imported. To import a WAV file, do the following:

Click the Phone System tab from the Admin Portal.
Click Auto-Receptionist.

Click Prompts Library.

Click the Import Prompts button.

Navigate to the prompt file location.

Select the file and click Open.
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Recording a prompt over the phone

Account admins and users with permissions can create a custom audio prompt. One way to create this
prompt is to record the prompt using your phone.

Click the Phone System tab from the Admin Portal.

Click Auto-Receptionist.
Click Prompts Library.
Click Record Prompts.
The Record Prompt window appears.
Enter a name in the text field next to Prompt Name.
Click Phone.
e Inthe Call me at field, choose a phone number from the drop-down menu if you have saved
numbers or type a phone number in the text field.
e Click the Call Now button, and RingCentral will call you to record your message. Record
your IVR prompt over your phone when prompted.
8. Click Done.
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Recording a prompt using your computer microphone

Account admins and users with permissions can create a custom audio prompt. One way to create this
prompt is to record the prompt using your computer microphone.

Click the Phone System tab from the Admin Portal.
Click Auto-Receptionist.
Click Prompts Library.
Click Record Prompts.
The Record Prompt window will appear.
Enter a name for your prompt,
Click Computer Microphone. Click Allow if RingCentral asks to record through your computer.
The Record Prompt window will appear
e When ready, click the red Record button to record or re-record your IVR prompt through
your computer microphone.
e Click the Play button to listen to your prompt and then click the Record button to re-record
your IVR prompt.
e Click the Upload button to save your recording to the Prompts Library.
9. Click Done.
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Company custom rules

Company custom rules allow you to create different call experiences for incoming callers.

When an incoming call is received that matches any custom rule conditions you have set, for example, Caller
ID, Dialed Number, or Date and Time, you can apply different call handling, such as playing the company
greeting, ringing a user extension, call queue, or shared line, or send the call to voicemail.

After you create a custom rule, be sure to test the rule to verify that it works as intended.

Creating a custom rule

Click the Phone System tab from the Admin Portal.

Navigate to Auto-Receptionist > General Settings. Select a site if you have a multi-site account.
Click IVR Settings.

Under Custom Answering Rules, click Add Custom Rule or Edit Custom Rule.

Click Add Rule.

LANIE I I



RingCentral MVP | Admin Guide | Auto-Receptionist

RingContral

el g

Trwew dHm T

Som

-
jo

U
1

A B
T
i e
il T = ]

of [mwpmrma Zerg

s o ey Sy
T e e ANy ' e Ty e Lo e e s e TR i

vy fimars

¥ by

awm

Ty Cal henidnyg
T W RS P T (M S TR PLTE g T T e Y L ey

[ TR | by =k

PEAPE AT LEE b DR L

B gy -
. A ST pEC
o

T e s L] FE AT A e—
Jnma
furs e o Tamrws
———
e a—
oM dErewnag AL

T S S — T g e e b Fw i my e e e b s e g b

Lo Sveveerrg Ras

T N R B L ST

6. Enter Your Rule Name, then click Next.
7. Define the call conditions, then click Next.

Continue to the following pages according to the rule condition(s) that you want to apply.
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Custom answering rule conditions

Custom rule condition - Caller ID

Caller ID applies the rule according to the phone numbers you specify. Be sure the specified number is caller
ID enabled.

Click the checkbox next to CallerID.

Enter the phone number or contact name and click Add.

Click Next.

Define the call handling action to be performed when the conditions are met. Call handling options
include Company Greeting, User Extension, Call Queue Group, Shared Line, Voicemail, and

Db e

Announcement.
5. Click Save.
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Custom rule condition - Called Number

Called Number applies the rule to the phone number dialed.

Click the checkbox next to Called Number.
Click Select Number, then select a number.
Click Done, and then click Next.

Define the call handling action to be performed when the conditions are met. Call handling options

include Company Greeting, User Extension, Call Queue Group, Shared Line, Voicemail, and

oD PR

Announcement.
5. Click Save.
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Custom rule condition - Date and/or Time

This condition applies rules based on a time of day, week, or date range.

1. Click the checkbox next to Date and/or Time.
2. Configure one of the following under Select When This Rule Should be Active.
o Weekly Schedule: Select the specific day of the week and a specific time to apply the
custom rule.
e Specific Date Range: Designate the dates when the custom rule begins and ends.
3. Click Next.
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4. Define the call handling action to be performed when the conditions are met. Call handling options

include Company Greeting, User Extension, Call Queue Group, Shared Line, Voicemail, and

Announcement.
5. Click Save.
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Custom answering rule call handling actions

e Company Greeting: Plays your company greeting. You can customize the company greeting as
needed.

User Extension: Routes calls to a user extension.

Call Queue Group: Routes calls to a call queue.

Shared Line: Routes calls to a shared line.

Voicemail: Routes calls to a voicemail box (message-only extension).

Announcement: Routes calls to an announcement-only extension.

Note: Customers with the RingCentral MVP Essentials plan will not see the Shared Line option since they
don't get it with their package.

Custom answering rule list
All created custom answering rules are listed when you follow these steps:

Click the Phone System tab from the Admin Portal.
Click Auto-Receptionist.

Click General Settings.

Click IVR Settings.

Under Custom Answering Rules, click Edit Custom Rule.

ko bdeE

To add a custom rule, click Add Rule. Follow the instructions on the previous pages. To validate the list of
created rules click Validate. To edit an existing rule, click Edit.
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RingCentral offers different types of groups for your phone system needs. Let’s take a closer look at these
groups:

e Call Queues are different from extensions. Call queues increase the efficiency of your company by
directing the calls to the right employees. Call queues can support up to 25 calls waiting in a call
queue. Queue overflow can be enabled to extend your call queue.

e Paging Only groups enable real-time one-way broadcasting through multiple desk phones and
overhead paging devices

e Shared Lines allow calls made to one phone number to be answered by multiple phones. Answered
calls can easily be handed off to other phones sharing the same phone number.

Note: Paging only and Shared lines are not available for on-line accounts.

e Park Locations are private locations for your employees to park and pick up calls. Create up to 100
park locations for different groups of users in your phone system.

e Call Monitoring allows you to set permissions that allow specific users to monitor the calls of other
users.

Note: This feature is only available for MVP Premium and Ultimate users only.

e Call Pickup Groups allow group members to answer each other’s calls from their own devices..

e Message-Only Extensions allow you to create a dedicated extension specifically for receiving voice
messages. All calls routed to this extension are automatically directed to the extension's voicemail
box.

e Announcements-Only Extensions allow you to create a dedicated extension specifically for playing
an announcement. All callers that are routed to this extension will only hear a recorded
announcement/greeting.

e Limited Extensions allow you to create an extension installed in a common area (meeting rooms or
in hotel rooms) for anyone who has the need to access basic inbound/outbound calling capabilities.



RingCentral MVP | | Call queues
138

Create a call queue when you want a specific group of users (such as Sales, Support, or Billing) to share
incoming calls. Each call queue can have an extension or direct (local or toll-free) number of its own. You can
define specific business hours for each call queue and set up email or text message notifications of any
missed calls or voicemails.

Adding a call queue group

1. Click the Phone System tab from the Admin Portal.

2. Click Groups.

3. Click Call Queues.

4. Click the New Call Queue button. The Add Call Queue window will appear.

5. Enter a Group Name and Extension Number.

6. Click Select Call Queue (optional) if you'd like to copy the settings from an existing call queue.
e Select the button next to the call queue name.
e Click Done.

7. Click Next.

8. Configure the following options:
a. Ifyoud like to have several managers for the call queue, select the button for Select
Managers From User List.
e Enter a PIN, then re-enter it on the fields provided.
e Select managers and specify their permissions.
e Click Next.
b. If youd like to have one manager for the call queue, select Use Manager’s Email.
e Enter the email on the Manager’s Email field.
e Click Next.
9. Select the users you'd like to add to the group from the Call Queue Members list.
10. Click Done.
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Configuring a call queue

140

After you have created a Call Queue, you can configure the Call Queue Info, Direct Numbers, Greeting, Call

Handling, and Messages & Notifications.

> OwbdpR

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Call Queues.
Select an existing Call Queue. If you don’t have any existing call queues, go to the previous page to

learn how to create one.

Edit your settings:
a. Call Queue Details

Extension Number
Group Name

Record Group Name
Company Name
Contact Phone
Manager Email
Password

Delete Group
Regional Settings
Business Hours
Address
Confirmation Message
Video Service

b. Direct Numbers

Add Direct Number

c. Greeting & Hold Music

Call Queue Greeting
Audio While Connecting
Hold Music

Interrupt Audio

Blocked Calls

d. CallHandling & Members

Business Hours
After Hours

Wait Settings
Display Settings
Overflow

Custom Rules

Call Queue Members

e. Messages & Notifications
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o Voicemail Greeting
o Message Recipient
o Notification Settings
6. Click Save.
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Configuring call queue-to-queue overflow

Call queue-to-queue overflow allows scalable management of inbound calls during heavier-than-usual or
peak-season inbound call activity. You can append existing queues to the original queue, so if all lines are
busy in the original queue, calls overflow to additional queues.

Call handling follows the call queue policy. Call queue overflow is supported for the Rotating and In Fixed
Order sequence protocols. The Simultaneous protocol is not supported.

The Overflow Call Queues section lets you enable, create, and manage your overflow queues.

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Call Queues.

Select an existing call queue group. The call queue group must be configured with either a Rotating

> oOwbdpR

or Sequential call handling protocol.

Click Call Handling & Members.

Click the arrow down additional options icon and click Overflow.

7. Click the toggle on to enable the Overflow Queue feature. Select a maximum of three groups from

o

the call queue list.
8. Click Save.
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Adding a direct number

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Call Queues.

Select an existing Call Queue.

Click Direct Numbers.

Click Add Direct Number.

Select a Location and follow these instructions for the Number Type you choose.
a. Local Number: Select Local Number. Provide the State and Area Code and select number.
b. Toll-Free: Select Toll-Free Number. Select a Toll-Free prefix and select a number from the

No s~ LDhR

list of available numbers.
c. Vanity: Select Vanity. Choose a number that helps customers remember your business
phone number. Click Search to see if it is available.
8. Click Next when finished choosing your number.
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Setting call queue greeting and hold music

If you would like your callers to hear a recorded greeting before being connected to a call group, turn on the
Call Queue greeting. In this section, you can also set the audio while connecting, hold music, and if you want

to interrupt audio.

Note: If you have set custom call queue hours, follow these steps for both the Call Queue Hours and After

Hours tabs.

To set call queue greeting and hold music, follow the steps below:

L e oA

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Call Queues.

Select an existing Call Queue.

Click Greeting & Hold Music.

Tick the checkbox for each of the following to enable the settings and click Edit:

Call Queue Greeting: Choose your preferred type of greeting:
o Default: Select Default if you want to use a system-default call queue greeting
o Custom: Select Custom and select how you'd like to set your custom recording:
m  Phone: Next to Call me at, choose a phone number from the dropdown
menu if you have saved numbers or type a phone number in the text field.
Click the Call Now button and RingCentral will call you to record your
message
m  Computer Microphone: Click Allow if RingCentral asks to record through
your computer. The Microphone Test and Record settings will appear.
When ready, click the red Record button to record your greeting through
your computer microphone. Stop the recording and listen to the playback
m Importing: Browse for a WAV or MP3 file you want to use. Click Open
Audio While Connecting: Set the audio to the following:
o Ring Tones: Select Ring Tones if you want your callers to hear ring tones while the
call is being connected
o Music: Select Music if you want callers to hear music
o Custom: Select Custom if you want to upload your own audio file. Click Browse and
select your audio.
Hold Music: Set what you want callers to hear when you put a call on hold
o Ring Tones: Select Ring Tones if you want your callers to hear ring tones while the
call is being connected
o Music: Select Music if you want callers to hear music
o Custom: Select Custom if you want to upload your own audio file. Click Browse and
select your audio.
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e Interrupt Audio: Set this if you want callers to hear an audio prompt playing in specific
intervals while waiting for a call queue member to answer the call. Select from the
dropdown list how often the audio will be interrupted by the prompt and set your Interrupt
Prompt:

o Default: Select Default if you want to use a system-default recording and select
your preferred audio from the options provided.
o Custom: Select Custom if you want to utilize a fully customized audio recording
using the available options.
7. Click Done.
8. Click Save.

Incoming call handling

Choose how you'd like each call queue to handle incoming calls. Set the order in which the calls will be
transferred to the members of the call queue.

Click the Phone System tab from the Admin Portal.
Click Groups.
Click Call Queues.
Click the name of the Call Queue you’d like to configure.
Select Call Handling & Members > Business Hours to edit your call handling settings.
Select the order in which calls are transferred to department members:
a. Rotating: Regularly changes the order that you ring available members to evenly distribute
the calls.
b. Simultaneous: Routes an incoming call to all available members at the same time.
c. Sequential: Ring available members one at a time in the order you set.
7. Click Save.

A L o oA
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Messages and notifications

In this section, set your message recipient, voicemail greeting, and notifications. RingCentral allows each
Call Queue a separate voicemail message to greet unanswered calls, as well as allowing you to set a recipient

for these voicemails.
Setting a voicemail greeting

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Call Queues.

Select a Call Queue.

Click Messages & Notifications.

Click Edit under Voicemail Greeting.

A window will appear displaying the current Voicemail Greeting. Choose your preferred type of

No v hscwbdbpR

greeting
e Default: Select Default if you want to use a system-default voicemail greeting.
e Custom: Select Custom and select how you’d like to set your custom recording.

o Phone: Next to Call me at, choose a phone number from the dropdown list if you
have saved numbers or type a phone number in the text field. Click the Call Now
button, and RingCentral will call you to record your message

o Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready; click
the red Record button to record your greeting through your computer microphone.
Stop the recording and listen to the playback

o Import: Browse for a WAV or MP3 file you want to use. Click Open.

8. Click Done.
9. Click Save.
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Setting message recipients

After you have set your Voicemail Greeting, you can set which users or call queues to receive messages. To
do this, follow the steps below:

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Call Queues.

Select a Call Queue.

Click Messages & Notifications.

Click Select Extension under Message Recipient.

A window will appear with a list of members to receive messages left for this call queue.
Select the button next to the recipient.

. Click Done.

10. Click Save.
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Setting voicemail-to-text transcription

The voicemail-to-text transcription provides a text version of your voicemail that allows you to get the gist
of the message. The voicemail transcription is delivered to your RingCentral mobile or desktop application
or viaemail.

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Call Queues.

Select an existing Call Queue.

Click Messages & Notifications.

Click Settings.

Click the toggle switch to enable or disable Voicemail-to-Text
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Setting notifications

As an administrator, you can set up notifications to be sent to your phone or email when voicemails, faxes,
missed calls, and text messages are received for each call queue. To do this, follow the steps below:

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Call Queues.

Select a Call Queue.

Click Messages & Notifications.

Click Settings.

Click Edit under Notifications.

A pop-up will appear with notification options. Set your notifications by checking the boxes and

© NOo LA WDNR

filling in email and phone numbers.
a. Click Basic Settings > Advanced Settings to see more detailed notification settings.
b. Setyour Advanced Settings. Here, you can customize your notifications for voicemail
messages, received faxes, and received text messages. You can choose different email
addresses and phone numbers for your notifications, and select options for email
attachments.
9. Click Save.
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Paging Only groups enable real-time one-way broadcasting through multiple desk phones and overhead
paging devices. Paging Only groups are great for a variety of locations such as warehouse/shipping centers,
retail stores, schools, and hospitals, among others.

You can page using a special phone with a paging soft- key, or by dialing *84 from your digital desk phone or
from your VolIP calling-enabled mobile phone. In each case, you need to set up the Group number or the
number representing a group of extensions receiving a paged message prior to the page.

Adding a paging only group

Click the Phone System tab from the Admin Portal.
Click Groups.

Select Paging Only.

Select New Paging Only button in the upper right.
Enter the Group Name and Extension Number.
Click Save.

S o o

Note: This feature is available for accounts with two or more users.
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Configuring a paging only group

After you set up a paging group, select the devices to receive pages from the list of paging devices and user
phones that have this capability.

Click the Phone System tab from the Admin Portal.
Click Groups.

Select Paging Only.

Select a Paging Only group.

ik obdpeE

In the Paging Only Details tab, edit your extension number, group name, disable the extension, or
delete the group.

Click Save.

Click the Paging tab.

Click Devices to Receive Page: Select the User Phones or Paging Devices to receive pages.

. Click Users Allowed to Page this Group: Select the users who are to be allowed to page.

10. Click Save.
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The Shared Lines feature allows calls made to one phone number to be answered by up to 16 phones as a

157

designated group. Multiple groups of shared lines can be set up. Answered calls can easily be handed off to

other phones sharing the same phone number.

Adding a shared line group

1. Click the Phone System tab from the Admin Portal.

2. Click Groups.

3. Click Shared Lines.

4. Click New Shared Line. The Add Shared Line window will appear.

5. Select alocation: Domestic or International.

6. Enter the Group Name, Manager’s Email, and Extension Number.

7. Click Next.

8. Follow the prompts to add phone lines, the order of phone number, and devices.
9. Click Save.
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Configuring a shared line group

Configure the Shared Lines group’s name, password, business hours, and regional settings. You can also
apply a template to the group. Edit your extension number, name, or delete your menu.

1. Click the Phone System tab from the Admin Portal.
2. Click Groups.
3. Click Shared Lines.
4. Select ashared line from the list.
5. Click Shared Line Details.
6. Edit the details under the following:
a. General
e Extension Number
e Group Name
e Manager Email
e Password
e Status
e Record Group Name
b. Settings
e Regional Settings
e Site
e Confirmation Message
e Business Hours
e Shared Lines Devices
e Automatic Call Recording
7. Click Save.

Adding adirect number

A direct number is a phone number that can be called without going through the auto-receptionist.

Click the Phone System tab from the Admin Portal.
Click Groups.
Click Shared Lines.
Select an existing Shared Lines group.
Click Direct Numbers.
Click Add Direct Number.
Select a Location and follow these instructions for the Number Type you choose:
a. Local Number: Provide the State and Area Code. Select one or more numbers and click Add
Numbers.
b. Toll-Free Number: Select Toll-Free Number and a toll-free prefix. Select one or more
numbers and click Add Numbers.

No vk oobdpeE
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c. Vanity Number: Select Vanity. Choose a number that helps customers remember your
business phone number. Click Search to see if it is available. Select a number and click Add
Numbers.
8. Click Next after choosing your number. Follow the prompts to purchase your new number.

Setting a greeting

Set a greeting and keep the default, or record a custom group greeting.

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Shared Lines.

Select an existing Shared Lines group.

Click Greeting and then click Business Hours.

Tick the checkbox below the following to enable the feature:
a. Shared Line Greeting
b. Audio While Connecting
c. Hold Music

7. Choose your preferred type of greeting:

a. Default: To use the provided greeting, click Default.

o 0k 0N =

b. Custom: Select Custom and select how you'd like to set your custom recording:

e Phone: Next to Call me at, choose a phone number from the dropdown list if you
have saved numbers or type a phone number in the text field. Click the Call Now
button, and RingCentral will call you to record your message.

e Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings appear. When ready, click the
red Record button to record your greeting through your computer microphone.
Stop the recording and listen to the playback.

e Importing: Browse for a WAV or MP3 file you want to use. Click Open.

8. Click Save.

Managing blocked calls

Select Blocked Calls tab to block specific calls or all calls for this call group. Then, set up the message blocked
callers will hear.

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Shared Lines.

Select an existing Shared Lines group.

Click Greeting and then click Blocked Calls.

Click Edit under Callers will hear section. The Callers will Hear window will appear.

A e o
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7. Click dropdown list under View In and select language.
8. Ticktoselect adefault greeting under Callers will hear. Click the play button to listen to the

preview.
9. Click Done.
10. Click Save.

Setting custom music on hold

You can customize Music on Hold for shared lines to tailor the caller's waiting experience. The Music on
Hold options include:
e RingTones
e Music: Acoustic, Beautiful, Classical, Corporate, Country, Holiday, Latin, Modern Jazz, Nature,
Reggae, World
e Upload custom file in WAV or MP3 format

To set up custom Music on hold:

Click the Phone System tab from the Admin Portal.
Click Groups.

Click Shared Lines.

Select an existing Shared Lines group.

Select Greeting and select Business Hours.

Under Hold Music, check Enable.

Click Edit under Hold Music.

Click the dropdown under Set Audio and select Custom.

0 © N A WD R

. Click Browse.

10. Select your audio.
11. Click Done.

12. Click Save.

Managing call handling

Review or change each option for handling incoming calls for both business hours and after hours.

Click the Phone System tab from the Admin Portal.
Click Groups.
Select Shared Lines.
Select an existing Shared Lines group.
Click Call Handling.
Configure the following under Business Hours:
a. When all lines are busy, forward calls to:

S o o
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161
e Click Edit.
e Select Group Voicemail or an extension.
e Click Done.

b. Select an option on the dropdown menu under Number of seconds to wait before
forwarding unanswered calls.
7. Click After Hours.
a. The Confirmation window will appear if the business hours for the group is set to 24 hours
a day. Click Yes and then change the business hours.
Click Save.
Click the dropdown menu under How to handle calls during after hours.
Click your selection.

® 20T

If you selected unconditional forwarding, enter the number where calls should be
forwarded under Forward Calls.
8. Click Save.

Managing outbound caller ID

Set up an outbound caller ID for the group, or use individual numbers as caller IDs for each line.

Click the Phone System tab from the Admin Portal.
Click Groups.

Click Shared Lines.

Select an existing Shared Lines group.

Click Outbound Caller ID.

Click the dropdown under Outgoing Call Displayed as.
Select Group or Individual Lines.

If you selected Group, click Edit below the dropdown box.

0 © N A WD R

Select a phone number you want to display as your caller ID number for the outgoing call. Click

Done.

10. Click Edit below Alternate Caller ID. Select a phone number you want to display as your Caller ID
number for Alternate Caller ID. Click Done.

11. Click Save.

Messages and notifications
Set up a group voicemail and notification options.
Setting up voicemail greeting

1. From the Admin Portal, select the Phone System tab.
2. Click Groups.
3. Click Shared Lines.
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4. Select an existing Shared Lines group.
Click Messages & Notifications.
6. Take Messages feature is enabled by default. To disable the group from taking messages during
business hours, uncheck Enable.
7. Click the Play button to listen to the default voicemail greeting. To customize, click Edit below
Voicemail Greeting.
8. Click the drop-down box under Set Greeting, then select Custom.
9. Click the tab corresponding to how you prefer to customize the greeting:
e Phone: Next to Call me at, choose a phone number from the dropdown list if you have
saved numbers or type a phone number in the text field. Click the Call Now button, and
RingCentral will call you to record your message.
e Computer Microphone: Click Allow if RingCentral asks to record through your computer.
The Microphone Test and Record settings will appear. When ready, click the red Record
button to record your company greeting.
e Importing: Browse for a WAV or MP3 file you want to use. Click Open.
10. Click Done.
11. Click Save.

b
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Setting a message recipient
Set a message recipient for a Shared Line.

Click the Phone System tab from the Admin Portal.
Click Groups.

Click Shared Lines.

Select an existing Shared Lines group.

Click Messages & Notifications.
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10.

Ensure that the checkbox for Take Messages is ticked.
Below Message Recipient, click Select Extension.
Select the extension.

Click Done.

Click Save.

Setting voicemail-to-text

164

The voicemail-to-text transcription provides a text version of your voicemail that allows you to get the gist

of the message. The voicemail transcription is delivered to your RingCentral mobile or desktop application

or viaemail.

No us~LDhR

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Shared Lines.

Select an existing Shared Lines group.

Click Messages & Notifications.

Click Settings.

Click the toggle switch to enable or disable Voicemail-to-text.

Setting notifications

Choose who will receive notifications for voicemail messages and how they will receive them.

No us~ bR
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10.

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Shared Lines.

Select an existing Shared Lines group.

Click Messages & Notifications.

Click Settings.

A pop-up will appear with notification options. Set your notifications by checking the boxes and
filling in email and phone numbers.

Click Basic Settings > Advanced Settings to see more detailed notification settings.

Set your Advanced Settings. Here, you can customize your notifications for voicemail messages,
received faxes, and received text messages. You can choose different email addresses and phone
numbers for your notifications, and select options for email attachments.

Click Save.
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Use Park Location groups to create a private location in which specific users can park and pick up calls. Once
users have been added to the group, the park location can be added to the user’s Presence on a desk phone
or HUD in the RingCentral app. You can have up to 100 park locations in your phone system.

Adding a park location

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Park Locations.

Click New Park Location. The Add Park window will appear.
Enter the Group Name and Extension Number.

Click Save.

S e o

Note: Only one call can be parked in each location at a time.
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Configuring a park location
After you have created a Park Location, you can edit its information and the users in the group.
To edit your Park Location’s Extension Number and Name:

Click the Phone System tab from the Admin Portal.
Click Groups.

Click Park Locations.

Select an existing Park Location.

Click Park Location Details.

Edit the Extension Number and Park Location.
Click Save.
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Adding members to a park location
To add or remove users from a Park Location:

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Park Location.

Select an existing Park Location.

Click Location Members.

Select the names of the Users that should be added to the list.

Click Save. If the added user/s belong to a ring group, all members of the ring group must be added
to the Users of the park location.

An Alert window appears as a reminder to set up the User's Presence. Click OK.

Set up Presence Appearance on the online account.
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Setting up presence appearance
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Click the Users tab from the Admin Portal.

Click the name of the user that was added to the park location.

Select Phones & Numbers.

Select Phones.

Select Presence.

Click Select a User.

Select the Park Location extension from the list.
Click Done.
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Call monitoring groups all authorized users to access calls made by other users in real-time. These functions
provide training, coaching, and QA tools for supervisors or other levels of the management team. They can

also help improve teams’ performance and productivity. The following actions are available for an

authorized user in a call monitoring group: Monitor, Whisper, Barge, and Take Over.

To set up call monitoring, you'll need to create a call monitoring group and configure it. The system prompts

you to select the users who will have permission to monitor, and lastly, select the users who can be

monitored.

After creating a call monitoring group, users who have permission to monitor others’ calls will use the

touch-tones on their phones to access the call monitoring features. These users will select a current call in
progress on their phones then press the touch-tone for the action they'd like to take.

You must have a supported device with presence capabilities to use this feature. The following devices are

supported:

Polycom

e Polycom IP650

e Polycom VVX 310
e Polycom VVX400
e Polycom VVX410
e Polycom VVX411
e Polycom VVX500
e Polycom VVX501
e Polycom VVX600
e Polycom VVX601
e Polycom VVX150
e Polycom VVX250
e Polycom VVX350
e Polycom VVX450
e Polycom CCX 400
e Polycom CCX 500
e Polycom CCX 600
e Polycom CCX 700

Cisco

e Cisco SPA525G
e CiscoCP8851
e Cisco SPA504G
e Cisco SPA509G
e CiscoCP7841
e Cisco 7841

e Cisco 8861
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Adding and configuring a call monitoring group

Click the Phone System tab from the Admin Portal.
Click Groups.

Click Call Monitoring.

Select New Call Monitoring.

Enter a Group Name.

Click Next.

Select the users that can monitor this group.

Click Next.

. Select the users that can be monitored by this group.
10. Click Save.

VPN VA WN R

Note: The users who will be monitoring (for example, supervisors) can add the users who are monitored (for
example, agents) in their desk phone Presence appearance. The desk phone may need to be rebooted after
these settings have been changed.
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Administrators can set and manage call pickup permissions for multiple users together. Pickup group Users
can answer each other’s calls from their own device by dialing *58 followed by the ringing extension’s
number. Administrators can set and manage call pickup permissions for multiple users at once.

Adding a call pickup group

To add a new call pickup group:

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Call Pickup.

Click + New Directed Call Pickup. The Add Directed Call Pickup window will appear.

In the Add Details tab, enter the group name and choose a site from the drop down menu.
Click Next.

A e o

Add Direcled Call Pickup =

©

Choose group members in the Select Members tab, where you can filter by using the Search field and by
dropdown lists for Department and Site.

7. Fromthe Name list, check the box to the left of any entry to include them in the group.
8. Click Save.
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Create an extension dedicated to receiving messages. All calls routed to this extension are automatically
directed to the extension’s voicemail box.

Adding a message-only extension

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Message-Only Extensions.

Click New Message-Only Extension. The Add Message-Only Extension window appears.
Enter the Extension Name, Short Extension Number, and Email.

Click Save.

S o o
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Configuring a message-only extension

After you've created a Message-Only Extension, configure the Extension Details, Direct Numbers, and
Messages & Notifications.

Managing extension details

Edit your extension number, name, or delete your extension.

1. Click the Phone System tab from the Admin Portal.
2. Click Groups.
3. Click Message-Only Extensions.
4. Select an existing message-only extension.
5. Click Message-Only Extension Details to edit the following:
e Short Extension Number
e Record Extension Name
e Extension Name
e Record Extension Name
e Company Name
e Contact Phone
e Email
e Status
e Delete Group
6. Click Save.

7. Click Settings to edit the following:
e Regional Settings
e Site
e Confirmation Message
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Recording an extension name

You can use this option to ensure the extension name is pronounced correctly by the system operator. You
can spell out the name the way it sounds to help the operator, or you can record the name in your own voice
and use it for announcements instead.

Click the Phone System tab from the Admin Portal.
Click Groups.
Click Message-Only Extensions.
Select an existing message-only extension.
Click Message-Only Extension Details.
Click Edit under Record Extension Name.
Select an option under Record by.
a. RingCentral text-to-speech
b. Record extension name:

e Phone: Choose a phone number from the dropdown list if you have saved numbers
or select Enter a new number and type a phone number in the field for Call me at.
Click the Call Now button, and RingCentral will call you to record your extension
name. Click Save.

e Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your voicemail greeting. Click Save.

e Importing: Click Browse and select the WAV or MP3 file you want to use. Click
Open. Click Save.

8. Edit the Greeting Name (optional).
9. Click Save.

No v hcoobdpeE
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Adding a direct number

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Message-Only Extensions.

Select an existing message-only extension.

Click Direct Numbers.

Click Add Direct Number. The Add Direct Number window will appear.

Select a Location and follow these instructions for the Number Type you choose:

No oA~ e

e Local Number: Provide the State and Area Code. Select one or more numbers and click Add
Numbers.
e Toll-Free Number: Select a toll-free prefix. Note that there is a $30 one-time set up fee per
number if you select 800 as your toll-free prefix. Select one or more numbers and click Add
Numbers.
e Vanity Number: Enter a number that helps customers remember your business phone
number. Click Search to check availability. Select a number and click Add Numbers.
8. Click Next.
9. Review the charges (if any) and click the acknowledge box.
10. Click Next.

ol
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Designating a message recipient

Choose an extension to receive and save messages.

© N
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Click the Phone System tab from the Admin Portal.

Click Groups.

Click Message-Only Extensions.

Select an existing message-only extension.

Click Messages & Notifications.

Click Select Extension under Message Recipient. The Select Message Recipient window will
appear.

Select the user.

Click Done.

Click Save.
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Setting a voicemail greeting

Set the voicemail greeting you would like to use for your Message-Only Extension.

1. Click the Phone System tab from the Admin Portal.

2. Click Groups.

3. Click Message-Only Extensions.

4. Select an existing message-only extension.

5. Click Messages & Notifications.

6. Click Edit below Voicemail Greeting. The Voicemail Greeting window will appear.
7. Choose your preferred type of greeting under Set Greeting:

a. Default: Select Default to set the system-default voicemail greeting. Select the language to
display the default greeting text under View In. Your selection here affects only your
current view of the greeting text, it will not change the greetings language setting.

b. Custom: Select Custom and select how you'd like to set your custom recording:

e Phone: Choose a phone number from the dropdown list if you have saved numbers
or select Enter a new number and type a phone number in the field for Call me at.
Click the Call Now button, and RingCentral will call you to record your extension
name.

e Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your voicemail greeting. Click the up arrow to
upload your recorded message.

e Importing: Click Browse and select the WAV or MP3 file you want to use. Click
Open.

8. Click Done.

9. Click Save.
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Setting voicemail-to-text

The voicemail-to-text transcription provides a text version of your voicemail that allows you to get the gist
of the message. The voicemail transcription is delivered to your RingCentral mobile or desktop application
or viaemail.

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Message-Only Extensions.

Select an existing message-only extension.

Click Messages & Notifications.

Click Settings.

Click the toggle switch on to enable or disable Voicemail to Text.
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Setting notifications

Choose who will receive notifications for voicemail messages and how they will receive them.

No v LODdR

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Message-Only Extensions.

Select an existing message-only extension.

Click Messages & Notifications.

Click Settings.

Click Edit under Notifications. The Notifications window will appear. Set your notifications by
checking the boxes and filling in email and phone numbers.

Click Basic Settings > Advanced Settings to see more detailed notification settings. Set your
Advanced Settings. Here, you can customize your notifications for voicemail messages, received
faxes, and received text messages. You can choose different email addresses and phone numbers for
your notifications, and select options for email attachments.

Click Save.
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Create an extension that only plays an announcement for your callers. All callers routed to this extension
will hear a recorded announcement, such as a holiday closure announcement.

Adding an announcement-only extension

1. Click the Phone System tab from the Admin Portal.

2. Click Groups.

3. Click Announcement-Only Extensions.

4. Click New Announcement-Only Extension. The Add Announcement-Only Extension window

appears.
5. Enter the Extension Name, Short Extension Number, and Email.
6. Click Save.
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Editing announcement-only extension details

S o o

Click the Phone System tab from the Admin Portal.
Click Groups.

Click Announcement-Only Extensions.

Select an existing announcement-only extension.
Click Announcement-Only Extension Details.

Edit the info for the extension under General:

Short Extension Number
Extension Name
Company Name

Contact Phone

Email

Status

Delete Group

7. Click Save.
8. Click Settings to edit the following:

Regional Settings
Site
Confirmation Message

187
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Adding a direct number

Click the Phone System tab from the Admin Portal.
Click Groups.
Click Announcement-Only Extensions.
Select an existing announcement-only extension.
Click Direct Numbers.
Click Add Direct Number.
Select a Location and follow these instructions for the Number Type you choose:
e Local Number: Provide the State and Area Code. Select one or more numbers and click Add

No s~ R

Numbers.

e Toll-Free Number: Select a toll-free prefix. Select one or more numbers and click Add
Numbers. Note that there’s a $30 one-time setup fee for each number if you select 800 as
your toll-free prefix.

e Vanity: Enter a number that helps customers remember your business phone number. Click
Search to check availability. Select a number and click Add Numbers. Note that there’s a
one-time setup fee for each vanity number you select.

8. Click Next.
9. Review the charges (if any) and click the acknowledge box.
10. Click Next.
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Setting an announcement

Customize a greeting for an announcement-only extension.

1. Click the Phone System tab from the Admin Portal.

2. Click Groups.

3. Click Announcement-Only Extensions.

4. Select an existing announcement-only extension.

5. Click Announcement.

6. Click Edit under Announcement Greeting. The Announcement Greeting window will appear.
7. Choose your preferred type of announcement under Set Greeting:

a. Default: Select Default to use a system-default announcement. Select the language to
display the default greeting text under View In. Your selection here affects only your
current view of the greeting text, it will not change the greetings language setting.

b. Custom: Select Custom and select how you'd like to set your custom recording:

e Phone: Choose a phone number from the dropdown list if you have saved numbers
or select Enter a new number and type a phone number in the field for Call me at.
Click the Call Now button, and RingCentral will call you to record your extension
name.

e Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your voicemail greeting. Click the up arrow to
upload your recorded message.

e Importing: Click Browse and select the WAV or MP3 file you want to use. Click
Open.

8. Click Done.

9. Click Save.
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Create limited extensions for installation in a common area (meeting room or hotel room) for anyone who
has the need to access basic inbound/outbound calling capabilities.

RingCentral provides the ability to separately purchase limited extensions as unassigned extensions,then
later set up and activate those extensions by assigning them. Bulk purchases of up to 1,000 extensions are
also supported.

A limited extension is an extension with limited features offered at a lower price. Unlike a user extension, a
limited extension is not tied to a specific user. For more information, visit RingCentral Limited Extension

Overview.

Note: This feature is available on an on-demand basis. Contact RingCentral Support to discuss the
requirements for enabling this feature for your account.

Adding a limited extension

Click the Phone System tab from the Admin Portal.
Click Groups.

Click Limited Extensions.

Click New Limited Extension.

Select a location and click Next.

S e o

Enter the quantity, and select the following:
a. CostCenter
b. State
c. AreaCode
d. Number Option
e. Site (if you have a multi-site account)
f.  Device for use as limited extension
7. Click Add.
8. Click Next.
9. Select your shipping preferences.
10. Click Next.
11. Confirm the order. An order summary is displayed.


https://support.ringcentral.com/article/9232.html
https://support.ringcentral.com/article/9232.html
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Once the purchase of a limited extension is complete, it will appear in your account with an unassigned

status. You can activate unassigned extensions as needed.

Once assigned, a limited extension can be unassigned or reassigned as needed.
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Assigning a limited extension
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Click the Phone System tab from the Admin Portal.
Click Groups.
Click Limited Extensions.

Click a limited extension with Unassigned status.

Fill out the required fields:

Click Save & Enable. The status for the extension becomes Assigned.

Extension Number
Extension Name
Site

Emergency Address
Extension Email
International Calling

194
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Editing limited extension info

Click the Phone System tab from the Admin Portal.
Click Groups.
Click Limited Extensions.

Click Limited Extension Details.
Edit the following under General:

S e o

Extension Number
Extension Name
Record Extension Name
Company Name
Contact Phone

Select an existing Limited Extension with Assigned status.

o

L
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e Email
e International Calling allowed
e Status

7. Click Save.
8. Edit the following under Settings:

Regional Settings

Template

Site (if you have a multi-site account)
Confirmation Message
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Recording an extension name

You can use this option to ensure the extension name is pronounced correctly by the system operator. You
can spell out the name the way it sounds to help the operator, or you can record the name in your own voice
and use it for announcements instead.

Click the Phone System tab from the Admin Portal.
Click Groups.
Click Limited Extensions.
Select an existing limited extension.
Click Limited Extension Details.
Click Edit under Record Extension Name.
Select an option under Record by.
a. RingCentral text-to-speech
b. Record extension name:
e Phone: Choose a phone number from the dropdown list if you have saved numbers
or select Enter a new number and type a phone number in the field for Call me at.
Click the Call Now button, and RingCentral will call you to record your extension

No AL R

name. Click Save.

e Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your voicemail greeting. Click Save.

e Importing: Click Browse and select the WAV or MP3 file you want to use. Click
Open. Click Save.

8. Enter a Greeting Name (optional).
9. Click Save.
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Adding a direct number

Click the Phone System tab from the Admin Portal.
Click Groups.
Click Limited Extensions.
Select an existing limited extension.
Click Phones & Numbers.
Click Add Direct Number. The Add Direct Number window will appear.
Select a Location and follow these instructions for the Number Type you choose:
e Local Number: Provide the State and Area Code. Select a Cost Center if you have more than

No v AR

one. Otherwise, it will be preselected. Select one or more numbers and click Add Numbers.
e Toll-Free Number: Select a toll-free prefix. Note that there is a $30 one-time set up fee per
number if you select 800 as your toll-free prefix. Select a Cost Center if you have more than
one. Otherwise, it will be preselected. Select one or more numbers and click Add Numbers.
e Vanity Number: Select a Cost Center if you have more than one. Otherwise, it will be
preselected. Enter a number that helps customers remember your business phone number.
Click Search to check availability. Select a number and click Add Numbers.
8. Click Next.
9. Follow the prompts to purchase your new number.
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Setting an announcement and enabling hold music

Customize a greeting for an announcement-only extension.

koo bdE

10.

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Limited Extensions.

Select an existing limited extension.

Click Announcement & Hold Music and then click Edit under Unavailable Greeting. The
Unavailable Greeting window will appear.

Choose your preferred type of announcement under Set Greeting:

a. Default: Select Default to use a system-default announcement. Select the language to
display the default greeting text under View In. Your selection here affects only your
current view of the greeting text, it will not change the greetings language setting. Click
Done.

b. Custom: Select Custom and select how you'd like to set your custom recording:

e Phone: Choose a phone number from the dropdown list if you have saved numbers
or select Enter a new number and type a phone number in the field for Call me at.
Click the Call Now button, and RingCentral will call you to record your extension
name. Click Done.

e Computer Microphone: Click Allow if RingCentral asks to record through your
computer. The Microphone Test and Record settings will appear. When ready, click
the red Record button to record your voicemail greeting. Click the up arrow to
upload your recorded message. Click Done.

e Importing: Click Browse and select the WAV or MP3 file you want to use. Click
Open. Click Done.

Ensure there is a check for Enable under Hold Music if you want callers to hear music whenever you
put the call on hold. If hold music is enabled, click Edit to set your hold music. The Hold Music
window will appear.

Choose your preferred type of audio under Set Audio:

a. Ring Tones: Select Ring Tones if you want your callers to hear ring tones while the call is being
connected.

b. Music: Select Music if you want callers to hear music. Select the type of music under Select
Music.

¢. Custom: Select Custom to upload your own audio file. Click Browse and select the WAV or
MP3 file you want to use. Click Open.

Click Done.
Click Save.
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Setting outbound caller ID

Select the phone number you want to display as caller ID for outgoing calls.

© NOo A WDNR

10.

11

Click the Phone System tab from the Admin Portal.

Click Groups.

Click Limited Extensions.

Select an existing limited extension.

Click Outbound Caller ID.

Click Edit under Existing Phone. The Select Number window will appear.

Select the number you want to use as your outbound caller ID. Click Done.

Click Edit under Alternate Caller ID if you prefer to set this option. The Select Number window will
appeatr.

Select the number you want to use as your alternate caller ID. Click Done.

Check the box for Display my extension number for internal calls if you want to display your
extension as your caller ID when making internal calls.

Click Save.
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This section provides you a view of all phones that are associated with your RingCentral MVP account. You
can also add phones and devices, change a phone, and reassign a phone from this section,

Viewing and editing devices

1. Click the Phone System tab from the Admin Portal.
2. Click Phones & Devices.
3. Click on the following tabs to see the following:
a. User Phones
b. Common AreaPhones
c. PagingDevices
d. Shared Lines
e. Unassigned
4. Click on adevice to view and edit details.

L
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You can search or filter the phones or devices by specifying search text, status, or device, and selecting the

search icon. The search displays results for devices meeting the search criteria in the device category.

Adding a device

You can add a phone or device by clicking Add Device in the upper right. See the next pages for more

detailed

instructions.

Adding a user phone

ik oobd e

Note: You can only add devices for one country at a time. Repeat the process for different countries as

needed.

Click the Phone System tab from the Admin Portal.

Click Phones & Devices.
Click User Phones.
Click Add Device.
Select a Location.

e Domestic

e International
Click Next.

Select a user to assign the phone to.

Select a device to buy.
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9. Assign an existing or a new number to the device and click Next.
10. Add an emergency address and click Next.
11. Select your shipping preferences and click Next.
12. Confirm your order by checking the acknowledgment box. Click Next.
Note: When adding international phones, you will also need to register an emergency address in the
selected country for your phone. Review these details when confirming your order.
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Adding a common area phone

A common area or hot desk phone provides hot desking, and enables any employee to log in to a shared
phone that adopts the user’s phone settings

Click the Phone System tab from the Admin Portal.

Click Phones & Devices.

Click Common Area Phones.

Click Add Device.

On the Add Hot Desk Phones window, enter the quantity and select a device. Click Add,
and then Next.

Add an emergency address. Click Next.

7. Select your shipping preferences and click Next.

8. Confirmyour order by checking the acknowledgment box. Click Next.

LAREIE S
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Adding a paging device
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A paging device is a wall-mounted speaker or amplifier that enables overhead paging. Follow the steps below
to add a paging device:

© N Uk~ ODdPRE

Click the Phone System tab from the Admin Portal.

Click Phones & Devices.

Click Paging Devices.

Click Add Device.

Enter a name for the paging device.

Click Next.

View the provisioning information for the device.

Click Done to add the paging device to your system.
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Changing a phone

To change the phone of a user:

> bdpe

5.

Click the Phone System tab from the Admin Portal.
Click Phones & Devices.

Locate the phone that you want to replace.

Click Change Phone from the more menu.

Select from the following options:

a. Order a new phone from RingCentral: We will ship you a new desktop IP desk phone if you
select this option. These phones are pre-configured and should be automatically
provisioned once connected to the internet.

b. Existing RingCentral phone: Select this option if you already have a desktop IP phone
purchased from RingCentral but not currently in use. You can also swap phones with
another user. A reboot is needed if you exchange phones with another user. Provisioning is
required if you select a phone not presently in use. For more information, visit Intro to
deskphones provisioning.

c. Phone not purchased from RingCentral: Select this option if you own a SIP phone not
purchased from RingCentral. Provisioning is required after assigning these phones to a
user. For more information, visit Intro to deskphones provisioning.

d. RingCentral Phone app: Select this option if you prefer to use RingCentral’s desktop
application for taking your calls. You can download the RingCentral app from the

RingCentral Downloads page.

Reassigning a phone

To reassign a phone to another user:

S e o

Click the Phone System tab from the Admin Portal.

Click Phones & Devices.

Locate the phone that you want to replace.

Click Reassign to from the more menu.

Select the user where you want to reassign the phone, then click Next.
You will be prompted with a warning message, click Yes to proceed.


https://support.ringcentral.com/article/4966.html
https://support.ringcentral.com/article/4966.html
https://support.ringcentral.com/article/4966.html
https://support.ringcentral.com/download.html
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Viewing shared lines

1. Click the Phone System tab from the Admin Portal.

2. Click Phones & Devices.

3. Click Shared Lines. The group assigned to a particular Shared Line and the Phones Assigned to that
shared line are listed.

4. Filter numbers by search term or device.

5. The Shared Line and Phones Assigned are shown here. If you have made any changes, click Apply.

1) —— P - Bl Lres

Adding an unassigned phone

An unassigned phone is an IP phone in your account that is not yet activated or assigned to a user. Use the

following steps:

Click the Phone System tab from the Admin Portal.
Click Phones & Devices.
Click Unassigned.
Click Add Device.
Select a Location.
a. Domestic
b. International
6. Click Next.
Select a device.
8. Click Next.

unhobdpeE
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9. Select your shipping preferences and click Next.
10. Confirm your order by checking the acknowledgment box and click Next.
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Enabling video calls

You can enable video on internal point-to-point calls in your RingCentral MVP account. Supported devices
include the Polycom VVX 501/500 and 601/600 (supporting detachable cameras for video calling).
Phones with video support include video codecs with audio for all outbound calls. No new firmware is
required for the Polycom phones to enable video.

This feature is available as a on-demand feature for Premium and Ultimate tiers. Contact support to ask

about this feature.

To enable video:

Click the Phone System tab from the Admin Portal.
Click Phones & Devices, then click User Phones.
Select a supported phone.

Check the box next to Enable Video Calling.

Click Save.

vk obdE

Note: You can enable video calling for multiple devices by multi-selecting the Polycom devices in the list and

enabling video calling in bulk.

The phone will be resynchronized to make and receive video calls with similarly configured devices within

your RingCentral MVP account.
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Hot desking or common area phone enables any employee to log in to a hot desk phone that adopts the
user’s phone settings. Employees who travel from different offices can share the same hot desk phone and
desk while keeping their own extension profiles and voicemail access.

Types of hot desk phones

The following configurations of hot desk phones that support access to hot desking are available to support

your business needs:

e Hot desk (common) phone: An employee visiting from a different office can log in to a hot desk
phone and use it as their own, accessing their own extensions, profiles, voicemail, and other phone
features. Hot desk phones do not provide any telephony support unless the guest user activates
them by entering their credentials (except for making emergency calls).

e Hot desking for limited extension: Limited extensions are installed in common areas (meeting
rooms or in hotel rooms) for anyone who has the need to access basic inbound/outbound calling
capabilities. With Hot Desking for Limited Extension, a visiting employee can log in to a limited
extension phone and use it as their own with access to full telephony features. Hot desking enables
field sales and remote employees to work in a variety of spaces when visiting different offices and
the fact that this feature is available on limited extension phones ensures that the hardware still
provides functional value for on-site employees in all other cases.

Phone support and setup

You can either purchase a new phone that supports Hot Desking, or convert an existing unassigned Polycom
VVX phone to a hot desk phone. Supported phone models are the Polycom VVX 310, 311,410,411, 500,

501, and 601.
Using hot desking for limited extension
Calls are routed to a Hot Desking for Limited Extension phone as follows:

e Callstothe Guest User: the limited extension device is added to the forwarding rules of User
Business Hours and After Hours (if it has forwarding rule). Calls are routed to a Limited Extension
device based on the active answering rule of the guest user.

e Callsto Limited Extension are still routed to its device: Extension, DID, or DL number, and paging
calls. However, calls to the phone number of the Limited Extension DL follow the guest answering

rules.

After logging out through the logout soft key on the physical phone device, the phone resumes operation as
a limited extension device.
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Note: This option is available for MVP Premium and Ultimate only.

Enabling a limited extension phone for hot desking

To enable a visiting employee to log in to a limited extension phone and use it as their own with access to full

telephony features:

Click the Phone System tab from the Admin Portal.
Click Phones & Devices.

Click Common Area Phones.

Select a Limited Extension to view the device details.
Click the checkbox for Use as Hot Desk Phone.

Click Save.

S L O A

Note: On the Phone & Devices page, the device type is now identified as Limited Ext + Hot Desk.

A login softkey is provisioned on the device. Once a guest user is logged in, the device details page displays

the guest user name.

Converting an unassigned phone to a hot desk phone

Converting an unassigned phone to a hot desk phone makes that phone only available for use in hot desking.

No minutes are included for any type of calls.

To convert an unassigned phone to a hot desk phone:

Click the Phone System tab from the Admin Portal.
Click Phones & Devices.

Click Unassigned. Select an unassigned phone.

Under Phone Details, select Convert to Common Phone.
Follow the instructions to complete the conversion.

unhobdpeE
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Unassigning a hot desk phone

You can unassign a hot desk phone to remove it from hot desking use, and return it to the list of unassigned

devices. To unassign a hot desk phone:

Click the Phone System tab from the Admin Portal.

Click Phones & Devices.

Click Common Area Phones.

Select a hot desk phone.

Under Phone Details, select Unassign Phone The phone is returned to Unassigned phones.

vk oObdpE

Logging out a hot desk phone

You can log out the currently logged in user from the hot desk phone. To log out a hot desk phone:

Click the Phone System tab from the Admin Portal.
Click Phones & Devices.

Click Common Area Phones.

Select one or more hot desk phones.

unhobdpeE

Click Logout.

The currently logged in users are logged out from the selected phones.
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Setting the hot desking session timeout

The hot desking session timeout specifies the time period when guest users will be logged out from phone
endpoints. The default session timeout is 12 hours.

Certain enterprises with a mobile workforce may use the ‘Never’ value for the timeout to configure that all
hot desk sessions in the account will not timeout. When using this option, the hot desk session can only be

logged out by a user from the phone.

To set session timeout for all hot desk phones on the system:

1. Click the More tab from the Admin Portal.
2. Select Security and Compliance.
3. Select Hot Desk Session Timeout.
4. Select the duration from the list provided. To configure no timeouts, select the Never value.
5. Click Save.
B - 4 @
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Assisted provisioning

You can

S e o
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provision supported third-party devices with your service. Follow these steps:

Click the Phone System tab from the Admin Portal.
Click Phones & Devices.
Click User Phones.
Select the device that needs to be provisioned.
Click Setup and Provision.
Select your phone model. If you have selected:
e Avaya IP Phone: Select the phone model, provide the phone’s MAC Address and click Next.
Proceed with the steps described in the wizard.
e Cisco/Linksys IP Devices: Select the phone model from the menu. Provide the phone’s IP
address and click Next. Proceed with the steps described in the wizard.
e Polycom IP Phones: Select the phone model from the menu. Provide the phone’s MAC
address and click Next. Proceed with the steps described in the wizard.
e Yealink IP Phone: Select the phone model from the menu. Provide the phone’'s MAC
address and click Next. Proceed with the steps described in the wizard.
e Other Phones: Click Select. The next window displays the SIP Configuration or information
needed for manual provisioning. Contact your manufacturer to know how to configure your
phone using these configurations.

Aadgn 41 TR
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RingCentral MVP supports automatic location detection of certain devices and apps. This allows the most
current location to be made available when a user dials 911 from these endpoints. Location detection is
based on the application or device's interaction with network infrastructure elements with known locations,
such as WiFi access points, IP address ranges, and/or Ethernet switch MAC addresses.

Note: This feature is currently in controlled release. Contact your RingCentral account manager to have this
feature enabled for your account.

Current support covers the following endpoints:

e RingCentral app for desktop
e Polycom VVX x50 hard phones

Setting up emergency response location

Emergency Response locations (ERLs) represent the business locations where end users will be using their
RingCentral service to make phone calls. The scope of an ERL depends on physical/geographic coverage
needs. It should be defined to assist emergency responders in locating a 911 caller in a reasonable amount of
time.

Typical examples include:

SOHO customer : Single ERL referring to a single address.

SMB customer : Single ERL referring to a single address and possible a suite # in an office building.
Enterprise customer: Multiple ERLs referring to buildings on a campus, buildings in different
geographic locations, possibly one ERL per floor in a multi-story office park.

1. From the Admin Portal, navigate to Phone System > Emergency Calling > Emergency Response
Locations.

2. Toggle the Enable Emergency Response Locations switch on to enable the feature.

Important note: This enables the use of emergency response location for your account. This action

is not reversible.

Click + Add Emergency Response Location.

Enter a Nickname for the emergency response location.

Click Edit under Emergency Address.

Fill up the address information, then click Done.

Click Add.

Note: You can also check Private Location to make the private emergency response location visible

only to the selected owner.

Nouhkow
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Automatic location updates for RingCentral app for desktop

The location detection for the RingCentral app for desktop is based on the app’s interaction with network

infrastructure elements with known locations, such as WiFi access points and/or 1P address ranges.

The RingCentral app for desktop dynamically detects and reports changes in WiFi BSSID or IP address. It
looks up the location and then updates the emergency location for the app.

Note that only the desktop version of the RingCentral app supports Nomadic 911. The web version doesn’t
support it.

Automatic location updates for compatible desk phones
Prerequisites:

e Polycom VVX x50 Desk Phone/s (VVX 150, 250, 350, or 450)
e Hardwired ethernet connection (WiFi connected Desk Phones are not supported)
e Managed ethernet switch/es (LLDP enabled)

RingCentral account admin defines a network map in the Admin Portal to specify on-net locations by IP
Address ranges with corresponding physical address/es or Chassis IDs of ethernet switches with
corresponding physical address/es. If location lookup is successful, the emergency address is automatically
updated upon restart.

Note: If location lookup is unsuccessful, the phone is deemed as Off-Net and a notification is sent to the
admin allowing them to deal with the situation. Phones in Off-Net status will enter a restricted calling state:
No PSTN calling, only calls within account.

Before enabling the Automatic Location Updates, you must add your ethernet switches to the Switch Map
or add your IP addresses to the IP Address Range Map.

Enabling automatic location updates of compatible desk phones

1. From the Admin Portal, navigate to Phone System > Emergency Calling > Automatic Location
Updates.

2. Click Status > Automatic Location Updates for Compatible Desk Phones.

Turn on the toggle switch for Enable Automatic Location Updates for Compatible Desk Phones.

w

4. Tick the checkbox for Accept legal disclaimers, then click Confirm.
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Setting up the network infrastructure with known locations

Location detection is based on the application or device’s interaction with network infrastructure elements
with known locations, such as WiFi access points, IP address ranges, and/or Ethernet switch MAC addresses.

Adding wireless access point to the wireless access point map

1. From the Admin Portal, navigate to Phone System > Emergency Calling > Automatic Location
Updates.

2. Click Wireless Access Point Map.

Click + Access Point.

4. Enter the BSSID (Mac address of the wireless access point) and Nickname of the Wireless Access
Point.
Note: BSSID is not the same as the SSID of the access point.

5. Select an Emergency Response Location, then click Save.

w

Adding an IP address range to the IP address range map

1. From the Admin Portal, navigate to Phone System > Emergency Calling > Automatic Location
Updates.

Click IP Address Range Map.

Click + Add Network.

Enter the Network Name and select the Site (for multi-site accounts).

Click + Add in the Public IP Address(es) section.

Select Single or Range, then enter the IP address or IP address range, and then click Save.
Click + Add in the Private IP Addresses section.

Select Single or Range, then enter the IP address or IP address range.

. Enter a Nickname and select an Emergency Response Location, then click Save.

10. Click Save.

VP NOUAWN

Note: IP address ranges need to be specified as the combination of public IP address and all private IP
ranges. For example: your devices are in the following private network range : 192.169.10.0 -
192.168.10.255. You also have two IP addresses from your Internet Service Provider. To define this network
you would add the network, add two single IP addresses as public IP addresses as well as one private IP
address range using the steps described above.

Adding an ethernet switch to switch map

1. From the Admin Portal, navigate to Phone System > Emergency Calling > Automatic Location
Updates.

2. Click Switch Map.

3. Click + Add Switch.
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4. Enter the Chassis ID and Nickname of the ethernet switch. In many cases, the Chassis ID will be the

MAC address of the switch.
5. Select an Emergency Response Location, then click Save.

Selecting a User extension to be treated as nomadic

After enabling the Automatic Location Updates, you can select a User Extension to be treated as nomadic.

1. From the Admin Portal, navigate to Phone System > Emergency Calling > Automatic Location

Updates.

2. Click Extensions.

3. Select the User extension to be treated as nomadic by clicking Activate at the top of the Status
column. To remove a User Extension, select the extension, then click Deactivate at the top of the

Name column.
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The Meetings tab is where you can see information and configure the settings related to your meetings.

Here, you can see the following tabs:

e Recording Management

e Rooms

e Meetings Settings

e Downloads . Ricoitfing Minagemai
L. 3
-

Accessing and managing Rooms

When you have purchased a RingCentral Rooms License and set up the hardware for your RingCentral
Rooms system, you can access and manage it on your online account.

1. Click the Meetings tab from the Admin Portal.
2. Click Rooms. You can view the following tabs:
e Rooms List: This menu lets you view the list of all Devices and Rooms in the account. It also
allows you to modify the Global Settings, add or edit Locations and Rooms, upgrade all
Devices, and export rooms.
e Calendars: This tab allows you to add Calendar Services (Google Calendar, Office 365,
Exchange) that can be integrated with RingCentral Rooms. It also lets you authorize or
deauthorize, sync, and delete calendars.

Rir _|
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Managing Meetings settings

RingCentral Video allows admins and users to conveniently control the features with a user-friendly
settings interface that is available on the RingCentral online account. Account admins have the capability to
enable and disable RingCentral Video features that will be applied for all RingCentral Video users on the

account.

1. Click the Meetings tab from the Admin Portal.
2. Click Meetings Settings.
3. Admins can enable and disable RingCentral Video features on their account. The following sections
are available:
a. Security
b. Basic
c. Recordings
d. Email Notifications
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The Call Log reports on inbound and outbound calls and faxes for the company number and specified
extensions. The Call Log is available as a Simple view, which concisely summarizes the calls, and as a
Detailed view, which shows additional call record details.

You can filter the call log records by number, time period, call direction or type of call (inbound or outbound).
Select your filter criteria, and click Apply to refresh the log. In Delivery Settings, you can set delivery of the
call log to an email address on a daily, weekly, or monthly basis, on a specified day.

In the Type column you can see the types of calls. In the Recording column, you will see an icon if the call has
been recorded. Click the play icon to hear a recording.

To access the call log:

1. Click the Reports tab from the Admin Portal.
2. Click Call Log.
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Downloading call log and recorded calls

You can download the Call Log in .csv format and the recorded calls in mp3 format from the Call Log page.
The downloaded file will only contain the details of the filter you have selected.

Downloading the Call Log and recorded calls may take some time and may possibly time out. The
Background Call Log feature makes it possible to avoid your downloads from timing out and lets you work in
the background or switch to another page on your RingCentral Online account. Contact Support or your
Account Manager to have the Background Call Log feature enabled.

To download your call log and recorded calls:

Click the Reports tab from the Admin Portal.

Click Call log.

Click the Type of View: Simple or Detailed.

Filter the information that you wish to include in the Call Log Report.

Click More to select other information filters.

Click Apply.

Click Download.

Call Log (csv) is selected by default. Select what needs to be downloaded: Call Log or Recorded
Calls or both. If you select Recorded Calls (mp3), all call recordings will be downloaded. Click
Download to save the file on your computer.

© No A WDd PR

Note: If the Background Call Log feature is disabled, you will not be able to exit from the current window
until the download gets completed. If the Backlog Call Log feature is enabled, a pop-up window will advise
that your download has started and may take a while depending on the size of the file and internet
connection. Click OK to close it.
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The Analytics Portal lets you access reports such as Adoption & Usage, Performance, Company Numbers,
Device Status, Live Reports, Meetings Dashboard, and Quality of Service. It also lets you view existing
Historical Reports under the Subscriptions tab.

To access the Analytics Portal:

1. Click the Reports tab from the Admin Portal.

2. Click Analytics.

3. Ifitisyour first time logging in, you will be asked to authorize the Analytics Portal to sign in with

your RingCentral credentials. Click Authorize.

4. The Analytics Portal contains the follow tabs:
e Adoption & Usage

Company Numbers

Meetings Dashboard

Performance Reports

Quality of Service

Rooms & Devices

Alerts

Subscriptions
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Adoptions and usage

Adoption & Usage (A&U) Analytics gives visibility into usage and adoption patterns of the RingCentral

products across your organization. You can gain intelligent insights on the following:

e if, and how, RingCentral products are being used (at the organizational level or across sites and
departments)
e determining the power users
e trends and patterns of usage
e who are the low users/non-users
e which locations/departments could benefit from a training session
e user preferences such as preferred devices
e most used endpoints, etc.
To access:
1. Click the Reports tab from the Admin Portal.
2. Click Analytics to open the Analytics portal on another page.
3. The Adoption & Usage tab is the landing page of the Analytics Portal.

From the Adoption & Usage tab, you can select to view the following tabs:

Overview: Dashboard showing all Message, Video, and Phone metrics
Message: RingCentral app

Video: RingCentral Video analytics

Phone: RingCentral Telephony/PBX

el Rlarsrngs i Hitag: Phoan
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Company numbers reports

The Analytics Portal can generate a report using Company Numbers. There are also a number of Key
Performance Indicators (KPls) available for this report.

Company Numbers KPIs include the following:
The number or percentage of all inbound calls answered on a company number

The number or percentage of all calls to a company number in which a Voicemail was left
The number or percentage of all calls that were missed (includes voicemail)

The total amount of handle time the user spent on the calls on a company number. Handle time is all

live talk time and all hold time

e The average duration of a company number call, from answered until terminated. This includes live
talking plus time on hold

e The number of calls placed on hold for the numbers selected, the average hold time, or the number
of abandoned calls put on hold

e The number of calls transferred, parked (or answered from park), total park time and the number of

calls abandoned while the caller was put on park

To access Company Numbers:

1. Click the Reports tab from the Admin Portal.
2. Click Analytics.
3. Click the Company Numbers tab.
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Performance reports

The RingCentral Performance Reports tab is an additional tool that enables you to research call records to
determine your business unit performance. By using Key Performance Indicators (KPI) as well as targeted
filters, Performance Reports assists you in combining user, queue, and call activity to evaluate performance.

Performance Reports offer the following features and benefits:

Dozens of available KPIs for a deeper understanding of performance
New modern interface, with extremely fast performance

Targeted filters available for all reports providing better investigation
Highly customizable reports to individualize reporting experience
Enhanced capabilities to better match customer behaviors

The Performance Reports page contains the follow tabs:

e Queues: Call queue performance for the call segment that is relevant to each queue
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e Users: User performance in the context of inbound and outbound calls for the call segment that is
relevant to each user. If User Groups are in use (Ultimate and Premium plans), only users from
queues and defined user groups are available for monitoring

e Calls: Lists the breakdown of the call records with basic metadata

To access Performance Reports:

1. Click the Reports tab from the Admin Portal.
2. Click Analytics Portal.
3. Click Performance Reports.
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Quality of Service reports

The Quality of Service reports provide near real-time information on the global health of the account and
RingCentral Video and allows for proactive monitoring and reactive troubleshooting of potential issues. It
gives you the ability to anticipate and diagnose call quality issues impacting your users globally before they
escalate to critical problems.

To access Quality of Service reports:

1. Click the Reports tab from the Admin Portal.
2. Click Analytics.
3. Click Quality of Service.

The Quality of Service page contains the following tabs:

e Overview: This tab enables you to:
o Monitor overall account level quality proactively.
o Monitor audio stream quality on top Geo locations.
o Monitor patterns of audio quality for top ISPs and Endpoints.
o Understand the impact of meeting stream volume on quality.
o Filter quality information with different dimensions.

e Extensions: The Extensions tab features QoS analysis by user name or extension. It displays the
aggregate data for an individual user, allowing for a much deeper analysis of the call and
RingCentral Video meeting quality by leveraging user-specific graphs and trends.

e Calls: The Calls tab lets you view call quality data at a per call level so that you can identify specific
quality issues.

e MOS Performance: The Mean Opinion Score (MOS) Performance dashboard provides an overview
of call quality levels based on the minimum and target MOS thresholds for the previous month.

e Meetings: This enables you to:

o Reactively troubleshoot when their employees report issues with their meetings.
o List down arecord of all meetings held within the selected timeframe.
o Filter by various dimensions to be able to narrow down the list of records.




RingCentral MVP | | Analytics
237

Rooms and Devices reports

The Rooms & Devices report provides admins the ability to proactively monitor the global health of the
company’s RingCentral Rooms and hard-phone infrastructure. The report can be used to identify issues
impacting users regarding service availability of Rooms and hard-phones.

The rooms part of this report provides an overview of the rooms' conditions over time, providing the trends
and patterns of the devices. It provides data about the rooms' location, health, and status. It also gives
information about the Host and Controller's model, operating system, app version, and status.

The Rooms & Devices page contains the following tabs:

e Overview: Provides the admins with visibility into the current state of RingCentral Rooms and
hard-phones globally.

e Rooms: Lets you filter data by name, location, date range, room health, room status, ISP, Host’s app
version, and Controller’s app version. This section is divided into 2 parts, Health Trend and Rooms
list.

e Devices: Provides a list of offline devices with detailed information now and in relation to a historic
(within the last 7 days) time period, to allow users to see the offline devices overtime

e Unprovisioned Devices: Devices that were recorded in the RingCentral system, but have never
been set up.

To access Rooms & Devices:

1. Click the Reports tab from the Admin Portal.
2. Click Analytics.
3. Click Rooms & Devices.

Creating analytics alerts

The RingCentral Analytics Portal allows you to create alerts based on your analytics data.

To create an alert, follow these steps:

Click the Reports tab from the Admin Portal.

Click Analytics.

Click Alerts.

Click Alerts List, then click Create New. For first time setup, click Create New in the middle.
Configure the parameters of your alert.

ko bdE

a. General Information: Enter the Alert Name and Alert Severity.
b. Alert Trigger: You can set your Target, Target Value, Trigger, Condition, Threshold,
Monitoring Timeframe, and Alert Frequency.
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c. Advanced Options: Monitor your specific endpoints, day of the week, time of the day, or
over a minimum call leg volume.
d. Delivery Channel: You have a choice to receive your alert notifications via email or
RingCentral app.

e. EditSettings: Alert owner canrestrict access to an alert to View only (locked alert) or
Edit (unlocked alert).

6. Click Create Alert.
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Creating report subscriptions

Subscriptions provide a way for you to automatically generate reports and send them via email to recipients.

For example, if you would like a report generated that shows the number of calls that were abandoned while

the caller was put on hold, you can do so with a subscription setting for a Queue Report.

To make use of the Subscription feature, you must first save a generated report. After that, you can use the

Subscription page to send the report via email.

To save a report for the example given above:

0 ©NOUA WD R

Click the Reports tab from the Admin Portal.
Click Analytics.

Click Performance Reports, then select Queues.
Click Select KPIs.

Tick the box for # Abandon (Hold)

Click Done.

Click Save in the upper right.

Enter a report name.

Click Save.

To create a subscription:

ko bdpE
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Click the Reports tab from the Admin Portal.

Click Analytics.

Click Subscriptions.

Click Create Subscription.

Under General Information, enter the subscription name. Click the dropdown menu for Report
Type and select (from the example above) Performance Report. Click the dropdown for Report and
select the name of the report you saved. Note that only reports you have generated are available to
you in this list.

Select the tabs.

Select the Email Delivery Schedule.

Select the File Type to be generated.

Enter the email address for the recipient of the report in the Email the report to field. You can
specify more than one email address by clicking the plus sign (+) and adding other email addresses.

10. Click Create Subscription.

Subscriptions should be created on reports that have preset date-time windows such as yesterday, last

week, last month, etc., in Performance Reports. Saving a report with a custom date range with specific dates

will result in the recipient receiving the same report repeatedly. The user who created the Subscription
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Report has exclusive permissions to see, edit, and delete the subscription. No other user will have access to
the subscription.
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The Billing tab leads to menus for managing your Usage, Calling Rates, Meetings (including licenses), and
Device Orders. View and edit your service plan, payment information, international calling plans, and cost
center codes here.

If enabled for your account through RingCentral support, you will also see a Professional Services menu item
in the Billing tab.

Note: Billing is an administrator function only. This option is not available to standard users.

Overview page

The Overview page of the Billing tab contains information about your service plan, additional services, and
payment information. This is the landing page of the Billing tab.
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Managing your service plan

Viewing/changing service plan

Click the Billing tab from the Admin Portal.

On the Overview tab, the service planis under Your Plan.

Click Change to open the Upgrade Subscription window.

Click here to open the RingCentral Plans and pricing page. To proceed with changing your Service
Plan, contact RingCentral Support.

> d e

- Chediwids

&

& loa “'ﬂﬂtlﬂ‘m I:I'I'I"I-I:l il

Prorméium

9 Lipgrada Seinmonphian L

o el kb -
i s & e =
I



https://www.ringcentral.com/office/plansandpricing.html

RingCentral MVP | Admin Guide | Billing

Canceling your service plan

PO Dd P

Click the Billing tab from the Admin Portal.
Under Your Plan, click Cancel.

Follow the instructions on the Cancel Service Plan window.

Click Close.
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Using auto purchase

The Auto Purchase feature ensures you will never run out of calling credits. The selected package will be
automatically purchased when you are running low on calling credits, which prevents any potential
interruption of service. Purchased funds will roll over month-to-month for up to 12 months.

To view and select options for auto-purchase:

1. Click the Billing tab from the Admin Portal.

2. Click Change under Auto-Purchase.

3. Select the Calling Credits Package you wish to purchase.
4. Click Save.
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Viewing your Service Billing Detail

The Service Billing Detail tab contains information about your next billing date, service name, discounts, and

charges.

1. Click the Billing tab from the Admin Portal.
2. Select Service Billing Detail.
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Viewing your Billing History
Billing History contains a list of your billing transactions and billing statements.
To view your billing history:

1. Click the Billing tab from the Admin Portal.
2. Click Billing History.

Click View at the far right to view and print your billing statement for the specified month
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Viewing your payment method information

The Payment Method contains the credit card information attached to the RingCentral account.

S e o

Click the Billing tab from the Admin Portal.
Click Payment Method.

View your Payment Information and Billing Address.

Click Edit.
Edit your card details and billing address.
Click Save.
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Licenses & Inventory

The Licenses & Inventory tab provides an overview of licenses and devices on your account in one place. You
can filter by product category, cost center, and site.

To access Licences & Inventory:

1. Click the Billing tab from the Admin Portal.

2. Click Licenses & Inventory to display a list that shows Product Name, Total, In-Use, Available, and
Actions.

3. Inthe Actions column, click the dropdown arrow to show additional details.
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Managing licenses

You can view, upgrade, and downgrade licenses and devices of users in your company’s RingCentral account.

To view your users’ active licenses:

>R

Click the Users tab from the Admin Portal.

Click Users with Extensions.

Hover on the user you want to manage then select the license under the Licenses column.
This will open the license details, including the License name and quantity.

To update your users’ licenses:

>R

Click the Users tab from the Admin Portal.

Click Users with Extensions.

Hover on the user you want to manage, then click the more button at far right.

Click Edit licenses and select the license you want for the user. You can also select Add-on licenses if
applicable to the license you are selecting.

Note: You can only upgrade a user to an available license in your inventory. If you don’t have
available licenses, you will need to purchase a new license.

Click Update.

Note: The license of a downgraded user will be placed in the license inventory for future use.

Viewing your usage

The Usage tab includes your total used plan minutes for the current billing cycle, SMS log, mobile users,
available included credits for your account, international calling credits, and purchased calling credits.

To view your Usage:

Click the Billing tab from the Admin Portal.

Click Usage.

Under General Usage, the Current Plan Usage shows how many minutes you have used on your
account’s Unlimited Usage.

Click View Log for Paid SMS Usage to filter and display the SMS logs of the account.

Calling Credits shows the remaining minutes on your account. The number of minutes depends on
the type of plan you have.

Click View Rates on Purchased Calling Credits to show the available purchased calling credits on
your account.
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Viewing mobile user history

A virtual extension is a user extension without an assigned digital line. Virtual extensions forward incoming
calls to mobile phones, extensions, or other external numbers and allow for limited outbound dialing. It
becomes a Mobile User extension if it makes or receives ten or more calls in a given month (billing cycle).

To view the mobile users in your account:

Click the Billing tab from the Admin Portal.

Click Usage.

Click View History on Mobile Users.

Review the page for the number of mobile users.

Filter your view and click Apply.

View the Renewal Period, Name, Extension, and Number of External Calls.
Click Done.
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Adding calling credits bundles

The Credits section in the Usage tab contains your calling credits bundle and international calling credit

bundle.

To add Additional Bundles:

1. Click the Billing tab from the Admin Portal.
2. Click Usage.
3. Toadd atoll-free minute bundle:

a.
b.
C.
d.

Click Add Bundle on Calling Credits.

Select toll-free minutes bundle from the dropdown list.
Click Next.

Confirm your purchase.

4. Toadd aninternational calling credit bundle:

a.

b.
C.
d

Click Add Bundle on International Calling Credits.

Select the international calling credit bundle from the dropdown list.

Click Next.
Confirm your purchase.
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Managing Calling Rates

The Calling Rates tab under Billing contains international calling rates and premium domestic rates.

Enabling international calling and SMS

Click the Billing tab from the Admin Portal.

Click Calling Rates.

Click Outbound Rates.

Toggle on the switches for International Calling and International SMS.
You can search for the country to view the call rate and SMS rate.

S o o o

To disable a specific country, do one of the following:
a. Tick the box beside the country, click Disable, and click Yes on the Confirmation window.
b. Click the More kebab icon at the far right of the country under Actions, click Disable, and
click Yes on the Confirmation window.
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Viewing inbound rates

The Inbound Rates tab shows the rates when you receive calls to your RingCentral local or toll-free number

from specific countries.
To view the Inbound Rates:

1. Click the Billing tab from the Admin Portal.
2. Click Calling Rates.
3. Click Inbound Rates.

Viewing premium rates
The Premium Rates tab shows the premium domestic rates.

To view the Premium Rates:

1. Click the Billing tab from the Admin Portal.
2. Click Calling Rates.
3. Click Premium Rates.
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Managing Purchases in the Billing tab
The Purchases tab gives you a catalog of purchase options in one convenient place.
1. Click the Billing tab from the Admin Portal.

2. Click on Purchase for an overview of purchase options.
3. Clickonany tile to see relevant purchase options, or use the Search field to type in your search

criteria.
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4. Click Add to Cart in the lower right corner to add your selection to your shopping cart.

5. Tobuy additional products, click Back in the upper left corner of the pane to return to the Purchase
overview page and continue shopping.

6. Or,click on the shopping cart icon at the upper right corner to access your shopping cart.

=0 5




RingCentral MVP | | Billing
257

Using the Shopping cart to check out

When you're finished shopping and are ready to check out, click on the shopping cart icon in the upper right
corner. A Review Items and Checkout window displays to lead you through completing the process. The
screen may vary depending on your selections.

Review Items

Review your purchases, change quantities or delete items.

Assign Site

In this pane, you can choose a site to which you want the new assets assigned. Use the Select Site dropdown
field in the upper right, or use the dropdown in the Site column. Assign all assets to the same site, or choose
Split in the Actions column to allocate resources to different sites. Click Assign to Selected, then click Next.



RingCentral MVP | | Billing

drera Enme mnd Lo

. Ciace CPEH Bunirssa iF Phons

Add Shipping Info

Choose a ship-to address from the Select Shipping Address dropdown. Choose Edit to modify an existing
address or New to add a new address. In the Attention to field, add a recipient name. Choose a shipping
method from the Select Shipping Method dropdown. Check the box to the left of the entry you want to
assign. Choose Split in the Actions column to allocate purchases to more than one recipient. Click Next.
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Review Order

The Review Order pane shows an itemized list of purchases for the current order and their cost breakdown.
Click the checkbox next to the acknowledgement at the bottom of the pane, then click Next.

irdl Price ZHRTITY r



RingCentral MVP | | Billing
260

View Statement

The View Statement pane shows a summary of all purchase and account details for your order. Click Print to
keep a hard copy for your records. Click Done to complete the transaction.
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Managing meetings in the Billing tab

The Meetings section allows you to manage RingCentral Video, including managing licenses, downloading
software, adding and viewing rooms, and managing settings.

RingCentral Rooms licenses

RingCentral Rooms offers a convenient way to start, join, and control RingCentral Video meetingsin a
conference room from an iPad or Poly controller. Use RingCentral Rooms to start or join RingCentral Video
meetings which are initiated from different endpoints. RingCentral Rooms supports up to 200 participants
in a single meeting.

RingCentral Rooms requires a RingCentral MVP subscription and add-on licenses for the RingCentral
Rooms conference rooms.

Adding a Rooms license

Click the Billing tab from the Admin Portal.

Click Meetings.

Click Rooms.

Click Add Licenses.

Enter the number of licenses.

Click Next.

Review the charges. Tick the acknowledge checkbox to confirm your order.
Click Next.

© No A~ WDdNR

Note: You can add a maximum of 50 RingCentral Rooms licenses at a time. If you plan to purchase more than
50 licenses in bulk, you must break the purchase into several orders.
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Managing device orders

The Device Orders management feature allows you to view past orders and edit those device orders that
are in pending status to change the devices ordered, or the shipping address.

An authorized agent can extend the deadline up to 9 hours from Admin Web after your initial order
placement. You can edit those orders during this hold period. An order can only be modified a single time.
After which, it is submitted immediately to the distributor for processing.

Click the Billing tab from the Admin Portal.

Click Device Orders.

Click Edit Order on a pending order.

Click the pencil icon to make changes. Select the items that you want to change and change the
devices (one or many) to the desired device.

Once completed, new charges (or credits) are displayed under Phone Order Charges/Credit.
6. Click Next.

PO Dbd e

b

liwamm [himia




RingCentral MVP | | Billing
263

7. Update the Shipping Address if needed. The shipping charge will be adjusted and will reflect on New
Shipping Fees.

8. You will see a pre-statement and statement with Adjustments for the credits and charges for new
phones.

9. Click Next.

10. Click OK to confirm that once submitted, you can no longer update the order.
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The order update is complete, and the order status is changed to Submitted. You can click View Order to see

the final order.
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Using the Cost Center Management feature

The Cost Center Management feature allows you to manage and monitor expenses for groups or individuals.
Administrators can assign purchases of RingCentral services to a department or an individual with cost
center codes. Each transaction can be assigned to a specific cost center code that you have created. You can
create cost center codes while you are in process or upload predefined codes.

Click the Billing tab from the Admin Portal.

Click Cost Center Management.

Click Cost Centers.

Select an existing Cost Center Code. If you do not have any cost center codes, see the next page on

PO bdpe

how to create one.
5. You will see the Cost Center’s summary, which includes:
a.  Number of users assigned to the Cost Center.
b. The Cost Center’s total recurring charges per month.
c. Billing Items - Assigned: queue/user extensions and DigitalLines.
d. Billing Items - Unassigned and Shared: company numbers.
6. Click See details for the complete list of Billing Items.

Note: To enable the Cost Center Management feature, contact your RingCentral account manager.
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Adding Cost Center codes

Click the Billing tab from the Admin Portal.

Click Cost Center Management.

Click Add Cost Center.

Enter your preferred Name and Billing Code (optional).
Click Save.

A wbde

Note: Administrators can also add a Cost Center Code while processing a transaction. When the
administrator is asked to assign a purchase to a Cost Center Code, there will be a button to Add New Code

the administrator can click.
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In the Admin Portal, the More menu lists many important features for your company’s phone system.

Audit Trail lets you find and capture changes made by users that affect system events,
configuration, and user accounts.

Service Status allows Users and Administrators to view any high level service impacting issues on
the RingCentral platform with or without logging in.

Appearance lets you add your company logo to your RingCentral online account. You can also link
your company logo to your company’s website for smoother navigation.

Directory Integration allows you to automatically provision users from your Active Directory or G
Suite corporate directory into RingCentral.

Multi-Site Settings allows you to configure and manage your different office locations under one
account.

Single Sign-On (SSO) lets employees in a company access multiple applications with one set of
credentials. RingCentral SSO supports the Kerberos network authentication service (on Windows),
as well as integrates with Google SSO.

Session Timeout lets you configure a session timeout for all users.

Hot Desk Session Timeout specifies the time period when guest users will be logged out from
phone endpoints, or allows you to configure no timeout.

Masked Numbers setting hides certain information from Administrators for a subset of users in
order to meet country-specific compliance requirements.

Trust Portal allows customers to access RingCentral's security and compliance documents. It
provides audit reports and compliance documentation to assist customers with their compliance,
regulatory, and data protection diligence.

Archiver lets you securely save your messages and recorded calls automatically and easily search
the stored data at any time from within your SFTP or Dropbox cloud storage account to quickly
retrieve the records.

App Gallery is where you can discover application integrations that are commercially available, and
where developers can showcase their integrations.

Developer Portal is a place where you request access to the RingCentral Connect Platform.
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Using the Audit Trail feature

The Audit Trail feature allows the Super Admin or a User assigned with a Billing Admin role to:

e Track the changes on the RingCentral account which can be used for auditing and/or

troubleshooting.
e Generate the report with filter options.

e See changes made by other Administrators (applicable to organizations with multiple

administrators who need a changelog in order to provide coordinated support).

e Detect failed logins and locked accounts.

Audit Trail captures changes to the following events:

Admin Level Changes:

268

e System events: Successful logins (Service Web only) and Failed login & Locked accounts due to bad
passwords (all clients, plus integrations).
e Phone System

o
o
o
o
e Users:
o

(o]

Company Info: Company Address, Directory Assistance, Caller ID Name.

Phone numbers: Company and assigned.

Auto-Receptionist: General settings.

Phones & Devices: User Phones, Common area phones, Paging devices, shared lines.

User list: Users with extensions and unassigned extensions.
Roles.

e Billing: License purchases, license deletes, upgrades/downgrades.

e Tools:

(e]

Account Settings: Custom Fields and Outbound Call Prefix.

User/Extension level changes
e Settings

o

User Name/Ext: User Details (partial); Phones & Numbers (partial, add/delete number
only); Screening, Greeting, & Hold Music; Call Handling & Forwarding, Messages.
Outbound Calls/Faxes: CallerID and Fax Settings.

Notifications: Messaging Notifications.

RingCentral app admin settings
e Administrators: Administrators added or removed (First Last, Ext.).
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e Company settings: Enable phone features (on/off); Allow employees to add people (on/off); File
sharing (service, on/off), for example Google Drive on/off, Evernote on/off, etc.; Allow Giphy sharing
(max rating), for example, Max rating of PG-13.

e Data Retention: Policy set to N days.

e Compliance exports: Exports (on/off); Request/ download export enabled/disabled for UserName;
Download requested by Name/ email.

Accessing the Audit Trail feature

1. Click the More tab from the Admin Portal.
2. Under Service Console, click Audit Trail.
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Audit Trail report details

When a particular event is captured, these details are provided in the report:

e Date/Time - changes logged using Coordinated Universal Time (UTC) and displayed based on
logged-in user’s regional timezone setting.

Change made by - person who made the change.

Role* permission level of the person who made the change.

Change made to - indicates which item was changed.

Item affected - indicates the configuration that was changed.

Change details - description of the change.

Endpoint*- application name.

IP Address* application IP address.

*Indicates these report fields are only available in a downloaded comma- delimited (CSV) log file.
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Search Capability

You can search records that provide report details by time periods: Today, Yesterday, Last 7 days, Last 30
days, Last 60 days, Last 90 days, and Last 180 days.

dawdf Thai
iy M Eigusi 2020
1 1
n il T A W W T i n
Lr} hp ! 14 L] m 1 il
Ll I o o) I =l 9]
ad w ¥r Fa k| i ]
Searching by Change

You can also search by specific change, such as a change made by a user (Change by) or a change made to
(Change to) a particular extension. This can be done by selecting one of these options in the menu. When
you select Change by or Change to, a list of extensions is displayed for you to choose which one of these is
affected.

Searching by Items Affected

The Items Affected menu lets you select the specific event items that can be searched. You can either select
from this list or choose All.

Downloading an Audit Trail report

Once you have searched and found information in Audit Trail, you can download an Audit Trail reportin
.csv format. To download, follow the steps below:

1. Click the More tab from the Admin Portal.
2. Under Service Console, click Audit Trail.
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3. Do an Audit Trail search.
4. When you would like to generate a CSV file containing the Audit Trail result, click the Download

button.
5. Click Download on the Confirmation window.

Note: Audit Trail is available to all tiers of RingCentral MVP accounts and is enabled by default. To disable
the feature, Contact RingCentral Support.
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Service Status

The RingCentral Service Status site allows admins and users to view any high level service impacting issues
on the RingCentral platform with or without logging in. This site allows customers to see by feature and
region what is being impacted. It also notifies the admin and users for service impacting issues via email and
SMS.

To login to the Service Status page from the RingCentral online account:

1. Click the More tab from the Admin Portal.
2. Under Service Console, click Service Status.

The Service Status page opens on another window.



https://status.ringcentral.com/
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Account linking

Account Linking is a solution that provides a set of features to support customers who are split across
different accounts, and allows account users to find one another across accounts on all endpoints. Large
customers may have this split because of a limit of number of users per account, or business needs for having
different accounts or billing.

Accounts are linked into a federation that includes:

e The ability to create accounts in multiple tiers, allowing for a mix-and-match of certain feature sets
e Aconsolidated company directory
e Non-metered extension-to-extension and direct number dialing support in the federation

Before setting up Account Federation:

1. Contact RingCentral support to request access to the Account Federation feature. RingCentral
support will help evaluate if your account qualifies for the feature.

2. The RingCentral support agent enables the Account Federation feature and adds your linked
accounts within your online account.

3. Unique extensions in the federation are preferred. If extensions are not unique, the support agent
may be able to update the extension numbers of the linked account for you by applying a template.

4. When the Account Federation setup is complete, all account users can find one another across
accounts on all endpoints.

Note: Feature not available for all accounts. Contact RingCentral support to evaluate if your account
qualifies for this feature.

Navigating the Appearance tab

The Appearance tab allows you to add a company logo to your RingCentral account, change the phone
numbers the users see in their online account profile, and customize the email notifications that you receive.

Company logo

The company logo will appear at the top-right corner of your online account once you log in. To upload and

link an image:
1. Click the More tab from the Admin Portal.
2. Click Account Settings.
3. Click Appearance.
4. Click Company Logo.
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5. Click Browse to browse your computer for an image to upload and select the file you want to use.
6. Click Open.
7. Enter the URL that will be opened when a user clicks on your image.
8. Click Save.
9.

View your logo in the top-right corner of your online account and test the URL by clicking on the
image.
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Profile number

In the profile tab, administrators have the option to choose which numbers are displayed on their user's

account page.

The number format may differ depending on the country code. If a user does not have a direct number, the
main number and extension will be displayed. If a user has multiple numbers, the user can click on the
drop-down arrow to view these numbers.

To select the numbers that users will see in their profile:

Click the More tab from the Admin Portal.
Click Account Settings.
Click Appearance.
Click Profile Number.
Select from the following options:
a. Direct Number and Extension.
b. Direct Number.
c.  Main Number and Extension.
d. Direct Number, Main Number, and Extension.
6. Click Save.
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Customizing welcome email

Whenever an admin creates a user extension, the user receives a welcome email to set up their account. You
can customize the email that the user receives and add your information.

To customize the welcome email sent to your new users:

Click the More tab from the Admin Portal.
Click Account Settings.
Click Appearance.
Click Email Notifications.
You may add the following optional information to your welcome email:
a. Custom Logo: Enter animage URL to customize the logo that appears in your email

ko bdpE

headers.

Message: Enter up to 750 characters.

Contact Email: Add your contact email.

Support Contact Phone Number: Add your company support contact phone number.
e. Support Website: Add your company website.

6. Tick the following checkboxes to add the info to your welcome email:

a0 o

a. Include main company number.

b. Include direct number.

c. Include RingCentral Support Center information.
7. Click Update Preview to see your email preview.
8. Click Save.

Note: To set the welcome email back to default, click Reset to Default.
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Archiver Settings

Archiver settings let admins and users control archiving independently. Super Admins and managers
automatically have Archiver access, and Super Admins can turn on this feature for any user. When a user’s
Archiver option is turned on, they can archive the data of their own user extension.

Enabling Archiver for Admins

Super Admins and Managers are predefined roles that have admin archiver access by default. Super Admins
can create a new custom role with admin-level archiving permissions. They can turn Archiver on for Admins
in Roles if already available or create a new custom role with Admin level archiving permissions.

Log into your RingCentral account as an admin.

Navigate to Users via the top bar.

Click on Roles in the side navigation bar.

Click on an existing role or create a new one.

Scroll down to the Features section and check the box next to Archiver for Admins.
Click Save.
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Enabling access for users

Super Admins and Managers can archive data for all; or enable users to archive their own data.

Log into your RingCentral account.

From the Admin portal (or My Extension for managers), go to More from the top navigation tabs.
Click on Archiver Settings in the left navigation bar.

Use the slider to enable archiver.
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Directory integration

Directory Integration allows you automatically provision users from your corporate directory into
RingCentral.

Active Directory

RingCentral integrates with Microsoft Active Directory to let you automatically provision users from Active
Directory to RingCentral.

The service leverages Okta so you can perform an initial import from Active Directory to RingCentral, and to
synchronize Active Directory and RingCentral on user status. Users are automatically enabled or disabled in
RingCentral as they join or move around your organization.

To set up the RingCentral directory integration service, follow these steps:

Click the More tab from the Admin Portal.
Click Account Settings.

Click Directory Integration.

Select from the following Directory Provider:

> bdpR
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e None
e Google Cloud Directory
e Active Directory
e SCIM
5. Enable your selected directory by following the steps provided.
6. Ifrequired, edit the extensions of provisioned users in User Management in the Admin Portal.
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Multi-site settings

Multi-Site Support provides a management solution for customers with multiple branch locations. Multi-Site
Support is available for RingCentral MVP Premium and Ultimate users with Multi-Level IVR enabled.
Accounts configured with multi-site support can enable the Site Code feature to define a dial plan for
intra-site and inter-site calling. This feature allows the administrator to allocate account user or group
extensions for defined sites.

To enable Multi-Level IVR mode, configure the dial-by- name directory, create at least one IVR menu and
enable the feature in Auto-Receptionist.

To enable your account to support multiple sites:

Click the More tab from the Admin Portal.

Click Account Settings.

Click Multi-Site Settings.

Toggle the switch on to Enable account support for multiple sites.
Configure site codes, if required for your dialing plan.

unhobdpeE

Your online account can now create and configure multiple sites. Site filters are available on pages with site
assets to allow you to view the list of assets by sites.
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Creating a new site

RingCentral Multi-Site support allows you to provision independent account configurations for your
individual sites, to enable you to uniquely register and manage each site from your account. Once Multi-Site
Support is enabled, you can create additional sites as needed.

To create a site, follow the steps below:

1. Click the Phone System tab from the Admin Portal.

2. Onthe Company Info page, click New Site.

3. Onthe Site Info page, enter the Site Name, Site Address, and Site Extension. Or, you may click
Select Site under Copy Settings from to copy settings from another site. Click Next.

4. Configure the Regional Settings and Business hours. Click Next.

5. Assign Numbers to the Site. You may assign existing numbers or add (and purchase) new direct
numbers. Click Next.

6. Onthe Caller ID Name page, enter the Outbound Caller ID Name.

7. Onthe VR Menu page, select an Existing IVR or a New IVR.

On the Summary page, you will be notified that the site is created successfully. Click Done. You can view or
edit site information within Phone System > Company Info.

ity
et

!E

o

¢

g
'



RingCentral MVP | | Account settings
284

Setting up site codes

Accounts configured with multi-site support can enable the Site Code feature to define a dial plan for
intra-site and inter-site calling. This allows users within a site to call each other using a short extension
number, and users between sites to use a full extension number, consisting of a site code plus the short
extension.

To set up your site codes:

Click the More tab from the Admin Portal.

Click Multi-Site Settings.

Verify that Multi-Site support is enabled.

Under Site Codes, click Enable Site Codes.

In the Extension Number Length window, select an appropriate digit length for the short extension

and the site code. The values must fall within the limits of the full extension number length, per the

maximum extension length of five digits* Click Next.

6. Inthe Provision Site Codes window, the system will suggest site codes for all sites, per selected
lengths for site code and short extension. Click Next.

7. Inthe Adjust Extension Numbers window, Existing extensions that have more digits than enabled

with site code need to be adjusted or use system suggestions. Click Confirm.

ko bdE

Extensions in the Users with Extensions view display a site code plus a short extension. For example: Site
Code: 11, Short Ext. #: 001, and Full-Ext #: 11001.

Note: A maximum extension length of six to eight digits is available on-demand for certain international
cases.
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Moving assets across sites

The Change Site function of Multi-Site Support allows you to move selected Users, IVR Menus, and Call
Queues to another site. This feature allows for individual or bulk movement of Users, IVR Menus, and Call
Queues between sites.

Moving users across sites

1. Click the Users tab from the Admin Portal.

2. Onthe Users with Extensions tab, check the box of the users you want to assign to a different site,
and click Change Site.

3. Select thessite.

4. You may check the option to Adjust time and regional settings to the settings of the new site? to
apply it to the moved users.

5. Click Change Site.
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Moving IVR menus across sites

Click the Phone System tab from the Admin Portal.
Click Auto Receptionist.

Click IVR Menus.

Select from the list of IVR Menus.

Click Change Site.

Select the site.

Click Change Site.
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Moving call queues across sites

S e o

Click the Phone System tab from the Admin Portal.
Click Groups.

Click Call Queues.

Select the Call Queues that you want to move.
Click Change Site.

288

You may check the option to Adjust time and regional settings to the settings of the new site? to

apply it to the moved Call Queue.
Click Change Site.

(=P ]




RingCentral MVP | | Security and compliance
289

Single sign-on

Single Sign-on allows employees in a company to access multiple applications with one set of credentials.
You can work with RingCentral Customer Support to set up Single Sign-on for your RingCentral services, or
you can set it up by yourself.

On Windows based systems, Single-Sign-on supports the optional use of your company’s Kerberos network
authentication service to authenticate clients.

RingCentral also integrates with Google SSO, which allows G Suite customers to use the Google SSO service
(offered as part of G Suite IDaaS) to sign into RingCentral. Google lists RingCentral as an approved SSO app
in their SAML apps catalog. You configure RingCentral for SSO in the G Suite Admin Console and configure
the RingCentral SSO as described here.

Configuring SSO
1. Click the More tab from the Admin Portal.
2. Onthe left-hand side, click Security and Compliance.
3. Click Single Sign-on.
4. Choose an optionto set up SSO:

e Set up SSO by yourself: Use the self-service Ul to configure the Service Provider (SP)
settings. Perform the steps in Set up Single Sign-On by Yourself .
e Contact Customer Support: Use RingCentral Customer Support to configure the Service
Provider (SP) settings. Click the View Detail link, and contact RingCentral support.
5. After configuring the SSO, you can turn on the SSO service for your company. To do so, check the
box next to Enable SSO Service.


https://docs.google.com/document/d/1h-izcZ-gSMDwW0vUJokciW7ppPNH2iKt/edit#heading=h.26sx1u5
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Setting up single sign-on by yourself
To set up SSO by yourself, upload your Identity Provider (IDP) SAML metadata, make sure the attribute is
mapped correctly, and download the metadata for importing it into your Federation Server:

1. Inthe Set up SSO by yourself box, click Set Up to set up SSO for the first time, or Edit to change your
configuration.

2. Under Upload IDP metadata, click drop down and select either Upload with file or URL. To upload
with a file, click Browse, select a file, and click Open. To upload with a URL, paste the URL and click
Import.

3. Select email attributes you want to use within your metadata from the drop down list under Map
Email Attribute to. If the email attribute is not recognized, type out the name of the attribute by
clicking Custom in dropdown.

4. Under Certificate Management, click Upload to upload a certificate and set the primary one. Click
Save.

5. Download the Service Provider metadata and import it into your IDP server to complete the
configuration on your IDP side.

6. Tick Enable SSO Service checkbox.

7. Click Save.
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Contacting support to enable SSO

This section describes how to prepare the request, and contact RingCentral Customer Support to configure
the Service Provider (SP) settings required to enable SSO on your IDP server:

1. Inthe Contact Customer Support box click the View Detail link, and perform the steps as described.

2. Get your SAML 2.0 metadata details from your Identity Provider (IDP), such as PingFederate, Okta,
or a homegrown IDP.

3. Contact RingCentral Customer Support to request Single Sign-on setup assistance. A support
member will ask for your SAML 2.0 metadata file and answer your Single Sign-On questions.

4. You will receive an email from RingCentral containing your SAML 2.0 SP metadata. Import the
metadata into your IDP server to complete the configuration on your IDP.

5. Check Enable SSO Service.

6. Click Save.
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Configuring session timeout

Configure a session timeout for all users on your account. If a user is inactive for a certain period of time, a
warning message will appear notifying the user that the session is about to expire. The user can click OK to
keep the session alive. However, if a user does not click OK before the time runs out, the user is logged out of
the system and is asked to log in again.

To set a time interval for your phone system’s session timeout:

Click the More tab from the Admin Portal.

Click Security and Compliance.

Click Session Timeout.

Click the drop-down to view a list of time intervals.
Select the time interval you would like to use.

Click Save.
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Enabling masked numbers

The Masked Numbers setting hides certain information from Administrators for a subset of users in order to
meet country-specific compliance requirements. This feature needs to be activated first before the
Unmasked Numbers permission can be accessed in Roles. Administrators with the Super Admin role will
automatically have the Unmasked Numbers permission enabled.

To enable Masked Numbers:

Click the More tab from the Admin Portal.

Click Security and Compliance.

Click Masked Numbers.

Check Activate Masked Numbers.

Click Accept & Save.

Click OK on the Alert dialog.

At this point, you can either create a role with the Unmasked Numbers permission enabled, or you

No v~ ODdR

can enable the Unmasked Numbers for arole.
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Accessing the Trust Portal

All current RingCentral MVP, RingCentral Contact Center, and data center compliance and security
documentation will be accessible via the portal. For questions, please contact your Account Manager or
Sales Representative.

To access the Trust Portal:

Click the More tab from the Admin Portal.

Click Security and Compliance.

Click Trust Portal.

Accept the terms, then click Login.

Click the report name to view or download the PDF.

vk obdpeE

e o P Confidensalty Matice and Confidantalny Tems

g Ty et sy o Sy e 7 g v e T | g e e e
g et At e v Gy 4w e e w = ke

s D B L il B e I b et P e P

SEDEOTY R DN e . "l"FHI"J"’_F—?"—

bﬁ-——;ﬂ-ﬂﬂM|

PN Tl
[

o I vnes 1pas anosssd . el A es =0 s Carfrs e ry Baroe o Cerideruarry Terrs

0 - (5] =



RingCentral MVP | | Apps and resources

296

Archiver

The RingCentral Archiver allows you to backup RingCentral data via Dropbox, SFTP, Google Drive, and Box

integration. This provides an automatic backup solution, as well as a convenient way of storing and

retrieving phone data.

To configure Archiver:

> OwbdpR

Click the More tab from the Admin Portal.

Click Apps and Resources.

Click Archiver Beta.

Connect RingCentral Archiver to one of the following:
a. Dropbox

b. SFTP

c. Google Drive
d. Box

e. Smarsh

Note: You can only connect to one storage per instance. For example, one cannot use Dropbox and
Google Drive at the same time

Click Sync Options.

When connected to the archiver account, you can enable or disable data backup by selecting Enable
Backup.

Select the types of Data to backup. By default, Call Recordings are backed up for admins and users.
Users can select for their own extensions whether to backup Call Recordings, Voice Mails, SMS
and/or Fax.

Note: Archiver is available to RingCentral MVP Premium and Ultimate customers. It is also available to

RingCentral customers in Canada, UK, and Europe.
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App Gallery

The App Gallery is a destination where you can discover application integrations that are commercially
available, and where developers can showcase their integrations.

To access the App Gallery via the online account:

1. Click the More tab from the Admin Portal.
2. Click Apps and Resources.
3. Click App Gallery.

A new window will open to the RingCentral App Gallery website.

o ——

Developer Portal

The RingCentral Developer Portal offers a set of tools and services to build, deploy, and manage custom
integrations using RingCentral APIs. With this, developers can build out-of-the-box integrations with
RingCentral to add powerful communication capabilities to business applications.

To access the Developer Portal via the RingCentral online account:

Click the More tab from the Admin Portal.

Click Apps and Resources.

Click Developer Portal.

A new window will open to the Developer Portal.

b e



https://www.ringcentral.com/apps/?compatibility=ringcentral
https://developers.ringcentral.com/
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SMS and MMS

There are two types of SMS:

e Person-to-Person (P2P) or standard SMS: Communication of two or more people over text
messaging. Sending text messages from your phone to another person's phone is an example of P2P.

e Application-to-Person (A2P) or High Volume SMS: A text message that a person receives from an
application. This includes, but not limited to, marketing messages, appointment reminders, chat
bots, virtual assistants, notifications, and one-time passwords (OTPs), or PIN codes.

Wireless carriers treat P2P and A2P differently in terms of the type and volume of traffic allowed.

RingCentral MVP enables you to send SMS and MMS messages a few different ways.

Business SMS and MMS

The RingCentral Business SMS and MMS feature allows you to send and receive text messages and
multimedia files with your business number. This feature is available for customers in the US and Canada
(SMS only in Canada) and automatically activated for RingCentral MVP users.

RingCentral also supports toll-free number SMS activation for US and Canada. Contact Support to process
this request.

You can use your RingCentral phone numbers for sending and receiving text messages via the RingCentral
app.

Group SMS

You can send a text message to several people (up to 10) at once via the RingCentral app. This will create a
text conversation with all parties.

RingCentral app currently supports group text messaging only to numbers from the US, Canada, and Puerto
Rico.

Sending a group SMS

1. Click onthe New actions plus button at the top right.
2. Select Send new text from the dropdown menu.


https://support.ringcentral.com/contact-support.html
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3. If you have several Direct Numbers or Digital Lines, click inside the Text from field and select your
preferred outbound caller ID.
4, Enter the names (from your contact list) or phone numbers of the people you'd like to text in the To
field (you can enter up to 10). Separate the numbers by a comma or semicolon.

5. Ensure the Create group text box is checked.

6. Click the Next button to navigate to the text message conversation.

7. Draft amessage in the message field at the bottom of the app.

8. Send the text message by pressing Enter or Return on your keyboard.
Bulk SMS

You can send the same message in bulk (up to 100 recipients) via the RingCentral app. Different from a
group message, sending a text message in bulk means sending the same message to multiple people in
separate messages.

Sending a bulk SMS

1. Click onthe New actions plus button at top right.

2. Select Send new text from the dropdown menu.

3. Ifyou have several Direct Numbers or Digital Lines, click inside the Text from field and select the
outbound Caller ID from which you'd like the text to come.

4. Enter alist of the names or phone numbers of the people you'd like to text in the To field.

5. Uncheck the Create group text box, so you can add more than 10 numbers/names (you can enter up
to 100).

6. Enter your message in the resulting text field. Attach files and insert emojis using the Attach file and
Emoji buttons (respectively).

7. Click the Send button to send the text message to all contacts provided.

Send targeted or bulk SMS campaigns using our programmatic AP| or ready-to-use app with a full
communications platform, deep insights, and the ability to ensure regulatory compliance.

With High Volume SMS, customers can send SMS at higher rates, send mass promotions, send automated
messages, appointment reminders, notifications, and more without having their messages blocked by the
carriers as long as they don’t contain shortened URLs or spam content.


https://developers.ringcentral.com/api-products/sms
https://www.ringcentral.com/apps/high-volume-sms
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High Volume SMS features

Whether you're sending promos for e-commerce, healthcare appointments, reminders in education,
chatbots in hospitality or anything in between, High Volume SMS provides functionality for all industries and
businesses of any size.

up to 250,000 text messages per day
automated message queuing
opt-out/opt-in handling

detailed reporting and error codes

API vs High Volume SMS app

The High Volume SMS API is configured for customers who require more sophisticated functionality and
want to build more customized workflows for their organizations. Our developers can review code samples
and start building your custom SMS app. To learn more, visit our AP| Reference Guide.

Availability and pricing

RingCentral MVP Standard with $50 MRR+ (Monthly Recurring Revenue), Premium, or Ultimate plans can
take advantage of High Volume SMS. Local (10-DLC) and toll-free numbers are supported in the United
States. Only Toll-free numbers are currently supported in Canada. High Volume SMS is priced at $0.007 per
message sent or received with no additional carrier fees, all on your RingCentral bill.

Getting Started

You must first enable your RingCentral number to send High Volume SMS. To do so, submit a request via the
enrollment form.

Note: If you use an existing RingCentral number, you can no longer use it for SMS across other products,
including the RingCentral app. Visit the RingCentral Service Desk or contact your RingCentral account
manager if you'd like to add another number to your account.


https://developers.ringcentral.com/api-reference/High-Volume-SMS/createA2PSMS

